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Regulatory Compliance

This product has been designed and
tested in accordance with accepted
industry standards, and has been
supplied in a safe condition. To review
the Declaration of Conformity, go to
http://www.keysight.com/go/conformity.

Warranty

THE MATERIAL CONTAINED IN THIS
DOCUMENT IS PROVIDED “AS IS,” AND
IS SUBJECT TO BEING CHANGED,
WITHOUT NOTICE, IN FUTURE
EDITIONS. FURTHER, TO THE
MAXIMUM EXTENT PERMITTED BY
APPLICABLE LAW, KEYSIGHT
DISCLAIMS ALL WARRANTIES, EITHER
EXPRESS OR IMPLIED, WITH REGARD
TO THIS MANUAL AND ANY
INFORMATION CONTAINED HEREIN,
INCLUDING BUT NOT LIMITED TO THE
IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR
A PARTICULAR PURPOSE. KEYSIGHT
SHALL NOT BE LIABLE FOR ERRORS
OR FOR INCIDENTAL OR
CONSEQUENTIAL DAMAGES IN
CONNECTION WITH THE

FURNISHING, USE, OR
PERFORMANCE OF THIS DOCUMENT
OR OF ANY INFORMATION CONTAINED
HEREIN. SHOULD KEYSIGHT AND THE
USER HAVE A SEPARATE WRITTEN
AGREEMENT WITH WARRANTY TERMS
COVERING THE MATERIAL IN THIS
DOCUMENT THAT CONFLICT WITH
THESE TERMS, THE WARRANTY
TERMS IN THE SEPARATE
AGREEMENT SHALL CONTROL.

KEYSIGHT TECHNOLOGIES DOES NOT
WARRANT THIRD-PARTY SYSTEM-
LEVEL (COMBINATION OF CHASSIS,
CONTROLLERS, MODULES, ETC.)
PERFORMANCE, SAFETY, OR
REGULATORY COMPLIANCE, UNLESS
SPECIFICALLY STATED.

Technology Licenses

The hardware and/or software
described in this document are
furnished under a license and may be
used or copied only in accordance with
the terms of such license.

U.S. Government Rights

The Software is “commercial computer
software,” as defined by Federal
Acquisition Regulation (“FAR”) 2.101.
Pursuant to FAR 12.212 and 27.405-3
and Department of Defense FAR
Supplement (“DFARS”) 227.7202, the
U.S. government acquires commercial
computer software under the same
terms by which the software is
customarily provided to the public.
Accordingly, Keysight provides the
Software to U.S. government customers
under its standard commercial license,
which is embodied in its End User
License Agreement (EULA), a copy of
which can be found at
http://www.keysight.com/find/sweula. The
license set forth in the EULA represents
the exclusive authority by which the
U.S. government may use, modify,
distribute, or disclose the Software. The
EULA and the license set forth therein,
does not require or permit, among other
things, that Keysight: (1) Furnish
technical information related to
commercial computer software or
commercial computer software
documentation that is not customarily
provided to the public; or (2) Relinquish
to, or otherwise provide, the

government rights in excess of these
rights customarily provided to the
public to use, modify, reproduce,
release, perform, display, or disclose
commercial computer software or
commercial computer software
documentation. No additional
government requirements beyond
those set forth in the EULA shall apply,
except to the extent that those terms,
rights, or licenses are explicitly required
from all providers of commercial
computer software pursuant to the FAR
and the DFARS and are set forth
specifically in writing elsewhere in the
EULA. Keysight shall be under no
obligation to update, revise or otherwise
modify the Software. With respect to
any technical data as defined by FAR
2.101, pursuant to FAR 12.211 and
27.404.2 and DFARS 227.7102, the U.S.
government acquires no greater than
Limited Rights as defined in FAR 27.401
or DFAR 227.7103-5 (c), as applicable in
any technical data.

Safety Notices

A CAUTION notice denotes a hazard. It
calls attention to an operating
procedure, practice, or the like that, if
not correctly performed or adhered to,
could result in damage to the product
or loss of important data. Do not
proceed beyond a CAUTION notice until
the indicated conditions are fully
understood and met.

A WARNING notice denotes a hazard. It
calls attention to an operating
procedure, practice, or the like that, if
not correctly performed or adhered to,
could result in personal injury or death.
Do not proceed beyond a WARNING
notice until the indicated conditions are
fully understood and met.

The following safety precautions should
be observed before using this product
and any associated instrumentation.

This product is intended for use by
qualified personnel who recognize
shock hazards and are familiar with the
safety precautions required to avoid
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possible injury. Read and follow all
installation, operation, and
maintenance information carefully
before using the product.

If this product is not used as specified,
the protection provided by the
equipment could be impaired. This
product must be used in a normal
condition (in which all means for
protection are intact) only.

The types of product users are:

— Responsible body is the individual or
group responsible for the use and main-
tenance of equipment, for ensuring that
the equipmentis operated within its spe-
cifications and operating limits, and for
ensuring operators are adequately trained.

Operators use the product for its intended
function. They mustbe trained in electrical
safety procedures and proper use of the
instrument. They must be protected from
electric shock and contactwith hazardous
live circuits.

— Maintenance personnel perform routine
procedures on the productto keep it oper-
ating properly (for example, setting the line
voltage or replacing consumable mater-
ials). Maintenance procedures are
described in the user documentation. The
procedures explicitly state if the operator
may perform them. Otherwise, they should
be performed anly by service personnel.

Service personnel are trained to work on
live circuits, perform safe installations, and
repair products. Only properly trained ser-
vice personnel may perform installation
and service procedures.

Operator is responsible to maintain safe
operating conditions. To ensure safe
operating conditions, modules should
not be operated beyond the full
temperature range specified in the
Environmental and physical
specification. Exceeding safe operating
conditions can result in shorter
lifespans, improper module
performance and user safety issues.
When the modules are in use and
operation within the specified full

temperature range is not maintained,
module surface temperatures may
exceed safe handling conditions which
can cause discomfort or burns if
touched. In the event of a module
exceeding the full temperature range,
always allow the module to cool before
touching or removing modules from
chassis.

Keysight products are designed for use
with electrical signals that are rated
Measurement Category | and
Measurement Category Il, as described
in the International Electrotechnical
Commission (IEC) Standard IEC 60664.
Most measurement, control, and data
I/0 signals are Measurement Category |
and must not be directly connected to
mains voltage or to voltage sources with
high transient over-voltages.
Measurement Category Il connections
require protection for high transient
over-voltages often associated with
local AC mains connections. Assume all
measurement, control, and data I/0
connections are for connection to
Category | sources unless otherwise
marked or described in the user
documentation.

Exercise extreme caution when a shock
hazard is present. Lethal voltage may
be present on cable connector jacks or
test fixtures. The American National
Standards Institute (ANSI) states that a
shock hazard exists when voltage levels
greater than 30V RMS, 42.4V peak, or
60VDC are present. A good safety
practice is to expect that hazardous
voltage is present in any unknown
circuit before measuring.

Operators of this product must be
protected from electric shock at all
times. The responsible body must
ensure that operators are prevented
access and/or insulated from every
connection point. In some cases,
connections must be exposed to
potential human contact. Product
operators in these circumstances must
be trained to protect themselves from
the risk of electric shock. If the circuit is
capable of operating at or above 1000V,
no conductive part of the circuit may be
exposed.

Do not connect switching cards directly
to unlimited power circuits. They are

intended to be used with impedance-
limited sources. NEVER connect
switching cards directly to AC mains.
When connecting sources to switching
cards, install protective devices to limit
fault current and voltage to the card.

Before operating an instrument, ensure
that the line cord is connected to a
properly-grounded power receptacle.
Inspect the connecting cables, test
leads, and jumpers for possible wear,
cracks, or breaks before each use.

When installing equipment where
access to the main power cord is
restricted, such as rack mounting, a
separate main input power disconnect
device must be provided in close
proximity to the equipment and within
easy reach of the operator.

For maximum safety, do not touch the
product, test cables, or any other
instruments while power is applied to
the circuit under test. ALWAYS remove
power from the entire test system and
discharge any capacitors before:
connecting or disconnecting cables or
jumpers, installing or removing
switching cards, or making internal
changes, such as installing or removing
jumpers.

Do not touch any object that could
provide a current path to the common
side of the circuit under test or power
line (earth) ground. Always make
measurements with dry hands while
standing on a dry, insulated surface
capable of withstanding the voltage
being measured.

The instrument and accessories must
be used in accordance with its
specifications and operating
instructions, or the safety of the
equipment may be impaired.

Do not exceed the maximum signal
levels of the instruments and
accessories, as defined in the
specifications and operating
information, and as shown on the
instrument or test fixture panels, or
switching card.

When fuses are used in a product,
replace with the same type and rating
for continued protection against fire
hazard.



Chassis connections must only be used
as shield connections for measuring
circuits, NOT as safety earth ground
connections.

If you are using a test fixture, keep the
lid closed while power is applied to the
device under test. Safe operation
requires the use of a lid interlock.

Instrumentation and accessories shall
not be connected to humans.

Before performing any maintenance,
disconnect the line cord and all test
cables.

To maintain protection from electric
shock and fire, replacement
components in mains circuits -
including the power transformer, test
leads, and input jacks — must be
purchased from Keysight. Standard
fuses with applicable national safety
approvals may be used if the rating and
type are the same. Other components
that are not safety-related may be
purchased from other suppliers as long
as they are equivalent to the original
component (note that selected parts
should be purchased only through
Keysight to maintain accuracy and
functionality of the product). If you are
unsure about the applicability of a
replacement component, call an
Keysight office for information.

No operator serviceable parts inside.
Refer servicing to qualified personnel.
To prevent electrical shock do not
remove covers. For continued
protection against fire hazard, replace
fuse with same type and rating.

PRODUCT MARKINGS:

The CE mark is a registered trademark
of the European Community.

&

Australian Communication and Media
Authority mark to indicate regulatory
compliance as a registered supplier.

ICES/NMB-001
ISM GRP.1 CLASS A

This symbol indicates product
compliance with the Canadian
Interference-Causing Equipment
Standard (ICES-001). It also identifies
the product is an Industrial Scientific
and Medical Group 1 Class A product
(CISPR 11, Clause 4).

KCC-REM-KST-
BLMooox

South Korean Class A EMC Declaration.
This equipment is Class A suitable for
professional use and is for use in
electromagnetic environments outside
ofthehome. AZ JIJI (@R E LSS
AJITI)0I I ELLE AS)EKX
DHEEININZMNHMA L= AEERE
Ol B2 FootAlJl b2t O, Ot 8 2 9
ANAUM MBSt RS 2R 2 U

Ct.

)54

This product complies with the WEEE
Directive marketing requirement. The
affixed product label (above) indicates
that you must not discard this
electrical/electronic product in
domestic household waste. Product
Category: With reference to the
equipment types in the WEEE directive
Annex 1, this product is classified as
“Monitoring and Control
instrumentation” product. Do not
dispose in domestic household waste.
To return unwanted products, contact
your local Keysight office, or for more
information see

http://about.keysight.com/en/companyinfo/e

nvironment/takeback.shtml.

y )
Atad

This symbol indicates the instrument is
sensitive to electrostatic discharge
(ESD). ESD can damage the highly
sensitive components in your
instrument. ESD damage is most likely
to occur as the module is being
installed or when cables are connected
or disconnected. Protect the circuits
from ESD damage by wearing a
grounding strap that provides a high
resistance path to ground. Alternatively,
ground yourself to discharge any built-
up static charge by touching the outer
shell of any grounded instrument
chassis before touching the port
connectors.

A

This symbol on an instrument means
caution, risk of danger. You should refer
to the operating instructions located in
the user documentation in all cases
where the symbol is marked on the
instrument.

&

This symbol indicates the time period
during which no hazardous or toxic
substance elements are expected to
leak or deteriorate during normal use.
Forty years is the expected useful life of
the product.
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Multi-Channel Reference Solution Introduction

Multi-Channel Reference Solution Introduction

This multi-channel reference solution can be used in particular to test:

— Multi-antenna techniques that are used in diversity

— Spatial multiplexing multiple-in, multiple-out (MIMO)

— Beamforming in cellular and wireless LAN applications

— Carrier aggregation
For further details refer to www .keysight.com/find/pxi-mimo.
Multi-channel transmitter and receiver testing may require synchronization of
multiple signal generators and/or signal analyzers in time and frequency. For
example, wireless LAN transmitters can be measured by multiple receivers operating
atthe same frequency and with acquisition timing aligned, and receivers can be
tested using synchronized signal generators.
The M338TAVSG and M9391A VSA can be configured to operate in multi-channel
configurations with a shared 100 MHz frequency reference, and an independent, or
shared local oscillator (synthesizer) for each channel. This allows them to operate at
the same frequency for multi-channel operation, and at different frequencies for
modes in which multiple carriers are used, but baseband timing alignment s still
required.
The arbitrary waveform playback of the MO381A VSG can be synchronized using
backplane triggering of the PXle chassis. The IQ acquisitions made by the M939TA
PXle VSA for demodulating multi-channel waveforms can be synchronized using a
synchronization technique using the backplane of the PXle chassis. For additional
information on multi-channel systems, refer to www.keysight.com/find/pxi-mimo.

The LTE/LTE-A Reference Solution can be assembled to make up
to 8x8 channel phase coherent measurements

What is in this Manual

The scope of this document is to present the processes of receiving and verifying
operation of the Keysight Multi-Channel Reference Solution (see
www .keysight.com/find/pxi-mimo). The overall process is as follows:

1. Unpack and inspect your solution.

2. Verify the contents of each box in your shipment matches the respective box
content list.

3. Install the software.
4. Install and cable the modules.

Keysight Y1299A-001 Reference Solution User's Guide 1
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Multi-Channel Reference Solution Introduction

5. Redeem your software licenses.

6. Complete the configuration of a simple multi-channel solution and verify oper-
ability.

7. Installation is complete. Proceed to use the multi-channel software tools ,to
automate alignments and and configure a complex multi-channel solution.
Develop your control programs with the help of the Multi-channel Demo Tool
source code and the product drivers.

For more information on LTE/LTE-A Multi-Channel Systems see:

— Solution Brochure 5991-4684EN

— Configuration Guide 5991-0897EN

2 Keysight Y1299A-001 Reference Solution User's Guide



Multi-Channel Reference Solution Introduction

Follow the Startup Sequence

WEGNNIER  Closely follow the startup process flow in this document.
Deviating from the sequence can cause unpredictable system
behavior, damage your system, and may cause personal injury.

Step 1: Unpack Step 2: Verify Shipment
and Inspect

e d

Step 3: Install Drivers and Multi-Channel Tools
Software

10 Libraries Suite Module software
and drivers

I Step 4: Install Modules and Assemble the Multi-Channel System

9

h Step 5: Make Quick Start Measurements.

Keysight Y1299A-001 Reference Solution User's Guide 3



Multi-Channel Reference Solution Introduction

Related Documentation

This document can be found at: http://literature.cdn.keysight.com/litweb/pdf/Y1299-
90001.pdf.

M9381A Related Documentation

The documentation associated with this product is available at the respective product
pages on keysight.com (go to Document Library > Manuals).

M9381A (see www .keysight.com/find/M9381A)
- M9381A Soft Front Panel help system
- M9381A Startup Guide (this document)
- M9381A VSA Programming Guide
— M9381A device driver APl references (IVI-C/IVI-COM)
— MO9381A Data Sheet
— M9381A Security Guide

M9391A Related Documentation

The documentation associated with this product is available at the respective product
pages on keysight.com (go to Document Library > Manuals).

M9391A (see www.keysight.com/find/M9391A)
— MO9391A Soft Front Panel help system
- M9391A Startup Guide
- M9391A VSA Programming Guide
- M9391A device driver API references (IVI-C/IVI-COM)
- M9391A Data Sheet
- M9391A Security Guide

Other Product Related Documentation

Depending upon your particular order, you may find the following product
documentation useful.

Additional Related Documentation at www.keysight.com
— MO9018A PXle Chassis (see www.keysight.com/find/M9018A)
— M9018A PXle Chassis Startup Guide (see M9018 Statup Guide)
— MO9036A PXle Embedded Controller
— M9036A PXle Embedded Controller Startup Guide (optional)
- MO9037A PXle Embedded Controller

4 Keysight Y1299A-001 Reference Solution User's Guide
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Multi-Channel Reference Solution Introduction

- MO9037A PXle Embedded Controller Startup Guide
- M9021A PCle Cable Interface
- Keysight M9021A PCle Cable Interface Module Installation Guide (optional)

— Download and save this CHM file from www .keysight.com/find/pxie-
multichassis

If you ordered the M9391A PXle VSA with the M9300A PXle
Frequency Reference (order option M9391A-300) and did not
order the M9381A PXle VSG be aware that the M9300A software
and documentation are not installed with the M9391A installer. To
install the M9300A software and documentation, run the M938x
installer, available at www.keysight.com/find/M9381A-driver.
(When you run the M938x installer, you have the option to install
only the M9300A-related files.b)

Keysight Y1299A-001 Reference Solution User's Guide 5


http://www.keysight.com/find/pxie-multichassis
http://www.keysight.com/find/pxie-multichassis
http://www.keysight.com/find/M9381A-driver

Step 1 - Unpack and Inspect the Modules

Step T - Unpack and Inspect the Modules

The modules are shipped in materials which prevent damage from
static. Modules should only be removed from the packagingin an
anti-static area ensuring that correct anti-static precautions are
taken. Store all modules in anti-static envelopes when not in use.

Electrostatic discharge (ESD) can
damage or destroy electronic
components. Use a static-safe work
station to performall work on
electronic assemblies. The figure (left)
shows a static-safe work station using
two types of ESD protection:
conductive table-mat and wrist-strap
combination, and conductive floor-mat
and heel-strap combination. Both
types, when used together, provide a
significant level of ESD protection. Of
the two, only the table-mat and wrist-
strap combination provides adequate
ESD protection when used alone. To
ensure user safety, the static-safe
accessories must provide at least 1
MQ of isolation from ground.

VWAGIINEN DO NOT use these techniques for a static-safe work station
when working on circuitry with a voltage potential greater than
500 volts

Inspect for Damage

After unpacking an instrument, inspect it for any shipping damage. Report any
damage to the shipping agent immediately, as such damage is not covered by the
warranty (see warranty information at beginning of this document).

See also: Appendix A - Return Instrument for Repair (page 100)

To avoid damage when handling a module, do not touch exposed
connector pins.

6 Keysight Y1299A-001 Reference Solution User's Guide
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See www.keysight.com/find/tips for information on preventing
damage to your keysight equipment.

Keysight Y1299A-001 Reference Solution User's Guide 7
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Step 2 - Verify Shipment Contents and Model Options

Chassis and General Modules

Qty Keysight Part Number Description

1 M9018A M9018A PXle Chassis (see
www.keysight.com/find/M9018A)

1 M9036A or M9037A PXle Embedded Controller

1-5 M9021A PCle Cable Interface

M9381A Shipment Contents

The Keysight M9381A PXle Vector Signal Generator is a multi-module instrument
(MMI), housed in a PXle chassis. The minimum Vector Signal Generator consists of the
software, chassis, a Keysight M9301A PXle Synthesizer, a Keysight M9310A PXle
Source Output, a Keysight M9311A PXle Digital Vector Modulator and a Keysight
M9300A PXle Frequency Reference. The M9300A may be used in this and other
configurations.

Items in this table are included in a single Keysight M9381A PXle Vector Signal
Analyzer Shipment. MultiChannel shipments have line item quantities adjusted to
accomadate the number of channels.

Qty Keysight Part Number Description

1 M9300-10002 Software and Product Information CD, contains: Soft Front
Panels, drivers, and all printed documentation in PDF
format (also available at
http://www.keysight.com/find/m9381a)

1 E2094-60003 Keysight 10 Libraries Suite CD

1 M9300-90090 Keysight M9391A PXle Vector Signal Analyzer and M9381A
PXle Vector Signal Generator Startup Guide in hard copy

1 5023-1450 Wrench, socket, extension, 5/16 inch, SMA

1 5002-3361 SMB/MMCX Cable Removal Tool

3 1810-0118 SMA (m) straight, 50 Q termination. These are attached to
the M930TARF/LO ports.

1*  M9300A (Optional) Keysight M9300A PXle Frequency Reference

1*  M9300-90001 (Optional) M9300A Startup Guide (ships with M9300A)

8 Keysight Y1299A-001 Reference Solution User's Guide
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Qty Keysight Part Number

1 M9307A
1 M9310A
1 M9311A
1 5972-3335
1 9320-6691
1 5962-0476
1 5959-4660

1=  8121-2063

1 8121-2175
4 8120-5091
1 1250-2316

1 W1312-20266
1 W1312-20267
4 W1312-20265

Step 2 - Verify Shipment Contents and Model Options

Description

Keysight M9301A PXle Synthesizer

Keysight M93T0A PXle Source Output

Keysight M9311A PXle Digital Vector Modulator

PXI Modular Product Startup Guide Reference
China ROHS Addendum for Signal Generator
Certificate of Calibration

Recommended Due Date for Adjustment/Calibration

(Optional) Cable, coaxial, BNC/male-SMB/female, 1200 mm
(ships with M9300A)

Cable, coaxial, SMB/female SMB/female (300 mm)
Cable, coaxial, SMB-SMB (120 mm)

Adaptor, coaxial, straight, SMA (f) to SMA (m)
Cable, semi-rigid, (SMA-SMA)

Cable, semi-rigid, (SMA-SMA)

Cable, coaxial, SMB-SMB (85 mm)

*The Keysight M9300A PXle Frequency Reference is required to configure a Keysight
M9381A PXle Vector Signal Generator. It is an option to the M9381A because it may
be ordered in, and shared by other instruments including the M9397A.

See also: Appendix B - Options (page 101)

Keysight Y1299A-001 Reference Solution User's Guide



Step 2 - Verify Shipment Contents and Model Options

M9391A Shipment Contents

Items in this table are included in a single Keysight M9391A PXle Vector Signal
Analyzer Shipment. MultiChannel shipments have line item quantities adjusted to
accomadate the number of channels.

Qty

Keysight Part
Number

M9300-10002

E2094-60003
M9300-90090

5962-0476
5959-4660
5023-1450
5002-3361
5972-3335
9320-6698
M9300A
M9300-90001
1810-0118

M9301A
M9350A
M9214A
8121-2063

8120-5091
8121-2100
8121-2175

W1312-20237 or
W1312-20271

1250-2316

Description

Software and Product Information CD, contains: Soft Front
Panels, drivers, and all printed documentation in PDF format
(also available at www.keysight.com/find/m9391a

Keysight IO Libraries Suite CD

Keysight M9391A PXle Vector Signal Analyzer and M93871A PXle
Vector Signal Generator Startup Guide in hard copy

Certificate of Calibration

Recommended Due Date for Adjustment/Calibration
Wrench, socket,extension, 5/16 inch, SMA

Cable removal tool, SMB/MMCX

PXIModular Product Startup Quick Reference

China RoHS Addendum for Vector Signal Analyzer
(Optional) Keysight M9300A PXle Frequency Reference
(Optional) M9300A Startup Guide (ships with M9300A)

SMA (m) straight, 50 Q termination. These are attached to the
M930TA RF/LO ports.

Keysight M9301A PXle Synthesizer
Keysight M9350A PXle Downconverter
Keysight M9214A PXle IF Digitizer

(Optional) Cable, coaxial, BNC/male-SMB/female, 1200 mm
(ships with M9300A)

Cable, coaxial, SMB/female-SMB/female (120 mm)
Cable, coaxial SMB/female SMB/female (85 mm)
Cable, coaxial, SMB/female SMB/female (300 mm)
Cable, semi-rigid, SMA/male-SMA/male, 32mm

Adaptor, coaxial straight, male-SMA to female SMA
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Step 3 - Install the Software

System Requirements

Topic Windows 7 Requirements

Operating Windows 7 (32 bit and 64 bit), WES7

system

Processor 1 GHz 32-bit (x86), 1 GHz 64-bit (x64), no support for Itaniumb4
speed

Available 4 GB minimum (8 GB recommended for 64-bit operating systems)
memory

Available disk 1.5 GB available hard disk space, includes:

space — 1 GB available for Microsoft .NET Framework 3.5 SP1
— 100 MB for Keysight 10 Libraries Suite
Video Support for DirectX 9 graphics with 128 MB graphics memory recommended

(Super VGA graphics is supported)

Browser Microsoft Internet Explorer 7.0 or greater
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Hardware Requirements

Topic Requirements

Chassis PXle or PXI-H chassis slot. The Keysight M9018A chassis is
recommended for phase coherent operation.

Controllers A PXlor PXI Express embedded controller or remote controller
(external PC connected to the chassis by a PCI-to-PXl interface) is
required.

Embedded Keysight M9036A or M9037A or an embedded controller that meets the

controller following requirements:

= PXle system controller (PXI-1 embedded controllers are not
compatible) Utilize a 2x4, or 4x4 PXle system slot link configuration.
Run one of the operating systems listed in System Requirements
(above).

Remote (for Keysight M9018A chassis use only) APC running one of the

controller operating systems listed in System Requirements above and a Keysight

M9021A Cable Interface x8 with one of the following PC interface

options:

- Keysight M9045B PCle ExpressCard Adaptor x1, with cable (for a
laptop PC) Keysight M9048A PCle Desktop Adaptor x8, with cable
(for desktop PCs)

Chassis Requirements

Recommended best practices to ensure proper and safe module operating conditions:

Ensure proper chassis air flow is maintained

Select a chassis that provides thermal protection if fans become inoperable or
forced air cooling is obstructed

Use slot blockers (Keysight model Y1212A, 5 per kit) and EMC filler panels in
empty module slots to ensure proper operating temperatures. Keysight chassis
Keysight M9018A chassis and slot blockers optimize module temperature
performance and reliability of test.

Set chassis fans to high or auto. Do not disable fans.

Position chassis to allow plenty of space around chassis air intake and fan
exhaust.

At environment temperatures above 45 °C, set chassis fan speed to high.
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M9018A Chassis Air Flow

7279

Air Intake Fan Exhaust

The MS0T8A has multiple airintakes. They are located at the lower sides, lower front,
and bottom of the chassis.

Power up the Controller

If you are using a remote controller and you have installed the
interface cable, you must power up the chassis BEFORE you
power up the PC. When you power down your chassis, Shut Down
the PC BEFORE you power down the chassis.

If you are using an embedded controller, complete the following steps:

1. Install the embedded controller module into the chassis. The Keysight
M9036A/37A PXle Embedded Controller and Keysight M9018A PXle Chassis
are recommended. Please refer to the embedded controller and chassis
documentation for further details.

2. Connect peripherals (mouse, keyboard, monitor).
3. Power up the chassis.

Software Installation Overview

This installation includes the following:

— Keysight 10 Libraries Suite (IOLS), which includes the Keysight Connection Expert.
This software is included with your shipment, and is also available at:
www.keysight.com/find/iosuite. This software must be installed first.

Version 17. 0 (or newer) of the Keysight |0 Libraries Suite is
required.

The embedded controllers coming from the factory, already have
the 10 Library Suite installed.

- Instrument software, which includes the soft front panel (SFP), device drivers (IVI-
C, IVI-COM, and LabVIEW G) and documentation for the M9381A PXle Vector
Signal Generator and M9391A PXle Vector Signal Analyzer. This software is
included with your shipment and is also available at:
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www.keysight.com/find/M9391A
www.keysight.com/find/M9381A

Software Installation Procedure

1. Install the Keysight IO Libraries Suite. Follow the installer prompts to install the
1O libraries.
2. Install the product software.
Ifyou have both Keysight PXle VSA and VSG, repeat the procedure with the
respective installer.
a. Launch the software installer.

Keysight M938x - InstallShield Wizard —

Select Features

KEYSIGHT

Select the features setup will install rECHNOLOGIES

Select the features you want to install, and dezelect the features you want to uningtall,

o : Dezcription
S [nstallation P

-[wf] +49300 Reference |nztallation M338x Application and Help
] M3301 /MI309 Spnthesizer Installation files to be installed

- [w] LabWIE'w 8.5 Drivers

- [w] LabWIE'w 8.6 Drivers

- [w] Labt/|Ev 2009 Drivers [32 & B4 bit)

- [wf] LabW/IEv 2010 Drivers [32 & B4 bit)

[ Al LabYIEW Drriver Yersions after 2010 (32 & B4

i | ] 3

.00 ME of zpace required on the C drive
20652914 kB of zpace available on the C drive

[ < Back ][ Mt ][ Cancel ]

L &

b. Follow the installer prompts. Choose a "Complete" installation to install
all software and documentation, or a "Custom" installation to select from
a listing of modules and other features.
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3. Complete the installation.
Embedded controller (M3036A, M9037A): Remote controller:

@ Mo. | will restart my computer later. 4=
2. Click on Finish. Tt bt MRS e g

3. Wait for the system to restart.

]
e

1. Select "Yes, I want to restart my (Follow these steps in order, or else instrument
computer now." This is the default damage may result.)
selection. 1. Select "No, I will restart my computer
ST e I e later."
i!- InstallShield Wizard Complete L B
\>I @ ‘ez, | want to restart my computer now, <l éjlr;vs-tiﬁliel[l \nﬁzﬂﬂ.‘}[:-;]r.l.l‘;l;le T HJ:'i
. I
3 © Mo, | vl restart my computer later. }? 7 es, | want to restart my computer now. f
Tt M b A ;o ’

<

i

2. Click on Finish.

3. Shut down the remote controller PC.
Use Start > Shut down.

4. Power down the chassis.
5. Power up the chassis.
6. Power up the remote controller PC.

.Keysight application software such as Signal Studio and the
89600 can be loaded at this point.

Installing the Multi-Channel Tools

Onthe Y1299-10001 DVD that accompnies your order is a set of four programs
designed to confinfigure, align and correct phase and timing in the multi-channel
system. This program set is the the named the Multi-Channel Tools.

Software

Verify that the following software is installed on the embedded controller:
1) 89600 VSA version 19

2) Signal Studio (N7624B LTE/LTE-Advanced FDD & N7625B LTE/LTE-Advanced TDD
used in this demo guide)

3) M9391 version (2.0.280 or newer)
4)M938x version (2.0.333 or newer)
5) M9018A version (1.4.397.1 or newer).
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6) FPGA version (1.05 or newer). A software tool for upgrading to version 1.07 can be
obtained here.

7) Multi-channel toolkit (1.0.4 or newer)

Installing the programs

1. Insertthe Y1299-10001 DVD and launch it on your PC

In the browser that appears, select the single button to install the utility pro-
grams on your PC

Follow the instructions to install the programs.
Once installed, goto Start >All Programs > Keysight > Multi-Channel Tools

Multi-Channel Tools folder will be four programs:

Multi-Channel PXle Config Utility: This program configures the backplane trig-
gering, alignments, self-test and 89600 VSA software-hardware configuration.

VSG Multi-Channel Demo Tool: This program provides control of the multi-
channel VSG, loading of corrections and waveforms, and playback.

VSG Correction Utility: This program determines phase and timing offsets
between channels and provides correction values.

VSA Correction Utility: This program determines phase and timing offsets
between channels and loads correction values into the 89600 VSA software.

Licenses are required to play waveforms generated from any Keysight Signal
Studio applications. To obtain a temporary license to run the program on a non-
Keysight owned computer, please contact your local Keysight representative
or obtain a trial license from Keysight.com.

You can download a temporary license from the Keysight website:

www.keysight.com/find/free_trials

If the 89600 VSA software was installed after the M9391A drivers, you will need to run
the 89601 Integration.exe application available in the M93971A install directory under
the folder 89601Role.
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e
€ |SUPIC ~[ 4 ||| Search av60170te )
Organize = Open Burn Mew falder B= = [ @
-
- I ”

¥ Fovorites * | Name Date modified Type

4. Downloads E y 161 10/17/20139:45 AM  File folder

‘# Dropbox & “i B9601Integration.exe 10/16/2013 5:51 PM  Application

= Recent Places
BE Desktop
. MPQ_Marketing
1 TFS VisStudio

Sl E11F i | 3

:$ 89601Integration.exe Date modified: 10/16/2013 5:51 PM Date created: 9/17/20132 9:10 AM
'1-1"_-:{:; Application Size: 26.3 KB
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Step 4 - Install the Modules

PXI hardware does not support "hot-swap" (changing modules
while power is applied to the chassis) capabilities. Before
installing or removing a module to/from the chassis, power off the
chassis to prevent damage to the module

All component modules foran M9381A or M9391A instrument are
factory tested, aligned, calibrated and shipped as a "bundle". Itis
important that you maintain the bundle when installing modules
or returning an instrument for repair

All component modules foran M9381A or M9391A instrument are
factory tested, aligned, calibrated and shipped as a "bundle". Itis
important that you maintain the bundle when installing modules
or returning an instrument for repair.

These modules can be used in a chassis with PXle or PXI-H
chassis slots.

Module Installation Process Overview

There are four standard multi-channel configurations. See Appendix C - Standard
Configurations (page 103) for details.

« The module can be installed in any PXle or hybrid PXI slot marked with a peripheral slot
o compatibility image (solid black circle for PXle, or solid black circle with the letter -H-
for hybrid).
1. Make sure that the line cord is plugged in to establish earth ground and that the
chassis power switch is Off.
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2. Ifthe chassis has multiple fan speed settings, ensure that the fan switch is set
to AUTO and the inhibit switch is set to DEF.

FAN INHIBIT
= B<
HIGH AUTO DEF MAN

3. Position the chassis to provide ample space around the chassis fan intake and
exhaust vents. Blockage by walls or obstructions affects the air flow needed for
cooling. (Refer to the chassis documentation for more information about
cooling).

4. Before inserting a module into the chassis, back the mounting screws out to
ensure that there is no interference between the screws and the mounting
rails.

5. See 2x2 M9391A and M9381A Instrument Connections (page 33) for configuring
two VSAs and two VSGs in a single chassis.
See M9391A Instrument Connections (page 26) for positioning the M9391A
modules in a single chassis.
See M9381A Instrument Connections (page 22) for positioning the M9381A
modules in a single chassis.

When using the Keysight M9018A Chassis you will achieve the
highest data throughput for the Keysight M9391A PXle Vector
Signal Analyzer by using Slots 2, 6, 11 or 15 for the Keysight
M9214A PXle IF Digitizer. They are "x8"slots and the others
are."x4". For further details see the Keysight MO018A Chassis
documentation. If you are using a non-Keysight chassis,
consult your manufacturer's documentation.

6. Holding the module by the injector/ejector handle, slide it into an available PXI
(or hybrid) slot, as shown in the following figure.
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o
ol @ NOTE: Generic module installation

®K \* @ shown. It may not reflect your module’s

actual size and chassis placement.

a. Install the module into the slot of the chassis by placing the module card
edges into the front module guides (top and bottom).

b. Slide the module to the rear of the chassis and ensure that the
injector/ejector handle is pushed down in the unlatched (downward)
position.

c. Slide the module completely into the chassis. When you begin to feel
resistance, pull up on the injector/ejector handle to fully inject the
module into the chassis.

7. Secure all modules to the chassis using the module mounting screws. Use a #1
Pozidriv® or a slotted screwdriver and torque to 5 Lb-In (0.57 N-m).
Performance may suffer if the screws are not tightened properly.

8. Verify that the PXI chassis fans are operable and free of dust and other
contaminants that may restrict airflow.

9. Installfiller panels and slot blockers after installing the modules. Missing filler
panels or slot blockers may disrupt air circulation in the chassis. The left-most
slot does not accept a slot blocker.

10. Your shipment included an Keysight M9310A PXle Source Output and an
Keysight M9350A PXle Downconverter. With these modules you received a
straight, coaxial adapter (1250-2316) (SMA female to SMA male). Connect this
adapter to the RF Out connector of each M9310A and the RF In connector of
each M9350A, and torque to 8 Lb-In (0.904 Nm). This will extend the life of
these often-used connectors.

11. Use the M9391A and M9381A Instrument Connections (page 31) to attach the
cables to the instrument. The torque specification for SMA connectors is 8 Lb-In
(0.904 Nm).
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12. Ifyouare using a PCle Cable Interface, such as the Keysight M9021, connect
the Cable Interface in the chassis to the PC host per the instructions that came
with the Cable Interface.

13. Power up the PXI chassis.

14. Remap the backplane triggers, if necessary. See Hardware Configuration
Considerations (page 1).

15. Ifyouare using a remote PC, reboot the PC host.
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Cable and Connector Care

Use the Keysight Cable Removal Tool to disconnect push-on cables from the module
front panel connectors.

To avoid damage to the cables or connectors, pull the cable
straight away from the connector. Do not use the tool as a pry bar.

cable removal tool
(p/n 5002-3361), provided in
your ship kit.
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M9381A Instrument Connections

Multiple M9381A PXle VSGs in a Chassis

Up to four M9381A PXle VSGs can be installed in a single MO018A 18-slot PXle
Chassis, sharing a single embedded controller, as shown here. These PXI VSGs share
one M9300A PXle Frequency Reference and can be time-synchronized with
backplane triggering to generate test stimulus for multi-channel receiver devices. The
PXIVSGs can also be configured to be phase coherent with Option 012 and cabling all
channels to use a single M9301A PXle Synthesizer module with Y1243A cable kit.

FAI &k @9 ¥ W # # ¥ & 9|9 ¥ ¥ ¥ ¥ ¥ ¥ ¥ B

H_J | I _J I J
Y Y ' Y
Controller VSG #1 VSG #2 VSG #3 VSG #4

Frequency

Reference

The recommended multiple PXI VSG system is configured as follows:

V/.EOBN
V10EG6IN
V10EBIN
vV 1L0EGBIN
VOLEBN
V10EBIN

1 2 3 4 5 6 7 8 9 1011 12 1314 15 16 17 18

Other module and instrument placements can be used, but this configuration
optimizes speed and makes cabling simpler for phase coherent configuration.
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The M9300A frequency reference module must be installed in slot
10 for proper time synchronization between instruments.

Cabling is different for time-synchronization-only (independent LO) configuration and
phase-coherent (shared LO) configuration.

Time-Synchronized, Multi-Channel PXI VSG (Independent LO)

When phase coherence is not required, cable the instrument as follows for time
synchronized multi-channel operation for independently tunable channels.

4 Independent LO Cable Connections:
m_ .
- Primary 100 MHz connection (8121-2175, long SMB-SMB)
- Secondary 100 MHz connections (8120-5091, short SMB-SMB)

- Semi-rigids

Some cabling diagrams that follow show a cable from Trig1 to
Trig1 between the M9391A modules. These cables are optional,
and are only used for the IF Flatness field calibration.

Primary 100 MHz - 8121-2175 Semi-rigid - various

AN KEYSIGHT  MO0IBA  sdvances s : s

...........

Phase-Coherent, Multi-Channel PXI VSG (Shared LO)

When the carrier phase must be aligned between channels (beamforming, relative
phase measurements), cable the instrument as follows:

.= Primary 100 MHz connections (8121-2175, long SMB-SMB)

- Secondary 100 MHz & IF connections (8120-5091, short SMB-SMB)
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_ . LO distribution connections (E6630-60004, SMA-SMA)
- Semi-rigids

- = Unused M9301A modules

Primary 100 MHz - 8121-2175 Semi-rigid - various Shared LO - E6630-60004 Unused M9301A

‘MfKEVSIGHT MSOTBA  Achanced S b . o e el

FKi 4 ¥ ® ¥ &« @ @€ @& ¥ g & ¢ § 5§ ? * =
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Single M9381A VSG

Ifyou are building an M9381A PXle VSA plus an M9391A PXle
VSG, see M9391A and M9381A Instrument Connections (page

31).
| MA KEYSIGHT  MS018A  advanced swich abric OO 3
o & 9 85 ¥ W & @ § ¢ gl ¢ @ © © ¢ ¢ ¢
o Te[We|® ® |9 e |® |® D ® ® D |© |
________ o . e e W% W B e B W O B

The recommended single PXI VSG system is configured as follows:
VSG: M9381A REF: M9300A
M9311Ain slot 2/3 M9300Ain slot 10
M9310A in slot 4
M9301Ain slot 5

VSG: M9381A

M9311Ain slot 2/3
M9310Ain slot 4
M93071Ain slot b

Recommendation: Install the semi-rigid cables first.
Torgue specification for all SMA connectors is 8 Lb-In (0.904 Nm).

REF: M9300A
M9300Ain slot 10

M9381A Cable and Module Table

Part Number Connection Cable Description

8120-5091 M9300A 100 MHz Out 1 to M930TA100  Cable, coaxial, SMB
MHz In (female)-SMB (female)

8120-5091 M9301A 100 MHz Out to M9310A 100 Cable, coaxial, SMB
MHz In (female)-SMB (female)
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Part Number
8120-5097

8120-5091

W1312-20266

W1312-20267

8121-2063

1250-2316

8121-2175

Connection

M9370A 100 MHz Out to M9311A 100
MHz In

M9310A Trig 1 to M9311ATrig 1 for Pulse
Modulation

M930TARF/LO Out TAto M9311ALO In

M9311ARF Outto M9310ARF In

This cable can be used to direct an
External Reference into the M9300A Ref
In connector.

M9310A RF Out connector saver

M9311ATrig 2 to M9214A Trig 1 *

Cable Description

Cable, coaxial, SMB
(female)-SMB (female)

Cable, coaxial, SMB
(female)-SMB (female)

Cable, semi-rigid, SMA
(male) - SMA (male)
Cable, semi-rigid, SMA
(male) - SMA (male)

Cable, coaxial, BNC (male)
- SMB (female), 1200 mm

Adaptor, coaxial, straight
SMA (male) - SMA
(female)

Cable, coaxial, SMB
(female)-SMB (female)
300 mm

*The 8121-2175 cable is not required for standard M9381A
operation. It is useful for power amplifier (PA) testing with the
M9391A. This cable improves repeatability by enabling you to
consistently measure the same portion of the input signal.

M9391A Instrument Connections

Multiple M9397TA PXle VSAs in a Chassis

Up to four M9391A PXle VSAs can be installed in a single M018A 18-slot PXle
Chassis, sharing a single embedded controller as shown here. These PXI VSAs share
one M9300A PXle Frequency Reference and can be time-synchronized with
backplane triggering to measure multi-channel transmitters and analyze multiple
channel devices. The PXI VSAs can also be configured to be phase coherent with
Option 012 and cabling all channels to use a single M3301A PXle Synthesizer module
with Y1243A cable kit. Slot blockers and EMC filler panels are installed in the empty
slots.
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The recommended multiple PXI VSA system is configured as follows:

<
©
o
w
~
=

V10E6N
VOSEBN
VLIO0EEN
VOSEEN
V910E6N
VOSEBIN
VLI0EEN
VOSEEIN

3 45 67 8 9 10 1112 13 14 1516 17 18

Other module and instrument placements can be used, but this configuration
optimizes speed and makes cabling simpler for phase coherent configuration.

The M9300A PXle Frequency Reference must be installed in slot
10 for proper time synchronization between instruments.

Cabling is different for time-synchronization-only (independent LO) configuration and
phase-coherent (shared LO) configuration. See the following sections for cabling
information.

Time-Synchronized, Multi-Channel PXI VSA (Independent LO)

When phase coherence is not required, cable the instrument as follows for time
synchronized multi-channel operation for independently tunable channels.

4 Independent LO Cable Connections:
m_ .
- Primary 100 MHz connection (8121-2175, long SMB-SMB)
- Secondary 100 MHz connections (8120-5091, short SMB-SMB)

- Semi-rigids
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Primary 100 MHz - 8121-2175 Semi-rigid - various

AV KEYSIGHT MOOTBA  Advanced Swkeh Fabic . BsEs

..... Chassis

Phase-Coherent, Multi-Channel PXI VSA (Shared LO)

When the carrier phase must be aligned between channels (beamforming, relative
phase measurements), cable the instrument as follows:

- Primary 100 MHz connections (8121-2175, long SMB-SMB)

Secondary 100 MHz & IF connections (8120-5091, short SMB-SMB)

— LO distribution connections (E6630-60004, SMA-SMA)

= Unused M9301A modules

Primary 100 MHz - 8121-2175 Semi-rigid - various Shared LO - E6630-60004  Unused M9301A
ANV KEYSIGHT  MSOTBA  asancasswich s S
,,,,,,,,,,,,
.

Single M9391A VSA
Ifyou are building an M9381A PXle VSA plus an M9391A PXle
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30

NOTE VSG, see M9391A and M9381A Instrument Connections (page
31).
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The recommended single PXI VSA system is configured as follows:
VSA: M9391A REF: M9300A

M9214Ain slot 6 M9300Ain slot 10
M93071Ain slot 7
M9350Ain slot 8

Recommendation: Install the semi-rigid cable first.
Torque specification for all SMA connectors is 8 Lb-In (0.904 Nm).

M9391A Cable and Module Table

Part Number Connection Cable Description
8120-5091 M9300A 100 MHz Out 1 to Cable, coaxial,
M9301A 100 MHz In SMB (female) -
SMB (female) 120
mm
8120-5091 M930TA 100 MHz Out to Cable, coaxial,
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Part Number Connection Cable Description
M9350A 100 MHz In SMB (female) -
SMB (female) 120
mm
8120-5091 M9350A 100 MHz Out to Cable, coaxial,
M9214A 100 MHz In SMB (female) -
SMB (female) 120
mm
8120-5097 M9350A IF Out to M9214AIF In Cable, coaxial,
SMB (female) -
SMB (female) 120
mm
W1312-20237 or  M930TARF/LO Out 1Ato Cable, semi-rigid,
W1312-20271 M9350A LO In SMA (male) - SMA

(male)

1250-23167 M9350A RF In connector saver Adaptor, coaxial
straight SMA
(male) - SMA
(female)
8121-20631 This cable can be used to direct Cable, coaxial, BNC
an External Reference into the (male) - SMB
M9300A Ref In connector. (female) 1200 mm

M939TA and M9381A Instrument Connections

This section contains a cabling diagram for the Keysight M9391A PXle Vector Signal
Analyzer with a Keysight M9381A PXle Vector Signal Generator. For cable part
numbers, see M9391A Instrument Connections (page 26) and M9381A Instrument
Connections (page 22).

The M9300A PXle Frequency Reference module must be installed
in slot 10 for proper time synchronization between instruments.
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100MHz 100 MHz:
BP0, n J 8P

\ | /A 72\
kO \ S |

[

@ Status
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2x2 M939TA and M9381A Instrument Connections

Two M9381A PXle VSGs and two MI9391A PXle VSAs can be installed togetherin a
single M9018A 18-slot PXle Chassis, sharing a single embedded controller, as shown
here. The PXI VSGs and PXI VSAs share one M3300A PXle Frequency Reference and
backplane triggering is used to create a 2-channel source and a 2-channel analyzer
for testing 2x2 multi-channel devices. Slot blockers and EMC filler panels are
installed in the empty slots.

AN KEYSIGHT LR T—— . s s .
o o | @ [} @ @ o @ [} @ o

Controller VSA#1 VEA#) Freg. VSG#1 VSG #2
Ref

The recommended 2x2 system is configured as follows:

<
©
o
W
~J
>

VLI0EBN
VOSEBN
VLOE6N

VOSEBIN
V10EGIN
VOLEBN
V10EBIN

1 2 3 4 5 6 7 8 9 10 11 12 1314 15 16 17 18

Other module and instrument placements can be used, but this configuration
optimizes speed and makes cabling simpler for phase coherent configuration.
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The M9300A PXle Frequency Reference module must be installed
in slot 10 for proper time synchronization between instruments.

Cabling is different for time-synchronization-only (independent LO) configuration and
phase-coherent (shared LO) configuration. See the following sections for cabling
information.

Time-Synchronized, Multi-Channel PXI VSA & VSG (Independent LO)

When phase coherence is not required, cable the instrument as follows for time
synchronized multi-channel operation for independently tunable channels.

2x2 Independent LO Cable Connections:
._ :
- Primary 100 MHz connection (8121-2175, long SMB-SMB)
- Secondary 100 MHz and IF connections (8120-5091, short SMB-SMB)

- Semi-rigids

Primary 100 MHz - 8121-2175 Semi-rigid - various

AN KEYSIGHT  MSOIBA s swcn : o
FKi A ¥ @ ¥ & @ € ®» ¥ |m ¥ & ® ¥ ¥ B ® »

SERERERERERERRNRNRNRERE NRERRREN

Phase-Coherent, Multi-Channel PXI VSA & VSG (Shared LO)

When the carrier phase must be aligned between channels (beamforming, relative
phase measurements), cable the instrument as follows:

2x2 Shared LO Cable Connections:
m_ .
- Primary 100 MHz connections (8121-2175, long SMB-SMB)

- Secondary 100 MHz & IF connections (8120-5091, short SMB-SMB)
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- Semi-rigids
_ . LO distribution connections (E6630-60004, SMA-SMA)

- = Unused M9301A modules

Primary 100 MHz - 8121-2175 Semi-rigid - various Shared LO - E6630-60004 Unused M9301A

ANV KEYSIGHT ~ MSOTBA  ssvrced i farc : R Or
FKi A o o o 5] o () () o | [ @ @ [ [} @ o

Up to 4-Channel M9391A and M9381A Instrument
Connections

The following example shows a 4-channel M9381A PXle VSG and 4-channel M9391A
PXle VSA. This can be configured using a single (M9036A or M9037A) embedded
controller, M9021A PCle cable interface modules (2 with M9036A and 1 with M9037A)
and PCle cable to connect the two M9018A 18-slot PXle Chassis. One M9300A PXle
Frequency Reference is installed per chassis and shared between all instruments in
that chassis. All channels within a chassis are synchronized with backplane triggering
and phase coherency is enabled with Option 012 and Y1243A cable kit to use one
M9301A PXle Synthesizer for the PXI VSAs and one for the PXI VSGs. Slot blockers
and EMC filler panels are installed in the empty slots.
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VSA VSA  Freq. VSA VSA
#ﬂ #12 ref. #3 #4
A A
( If \FH( | \
AV KEYSIGHT s e s

Controller —

(VEKEBGHTIE — e ) it
PXi_ 4 o o 06 ¢ ©6 6 0 0|8 O ¢ © ¢ & ¢ © @

[ | | |
PCle VSG VSG  Freg. VSG VSG
interface  #1 #2 ref. #3 #4

Keysight Y1299A-001 Reference Solution User's Guide



Step 4 -Install the Modules

The recommended 4x4 system is configured as follows:

Chassis #1

VOSEGN
VOGEBN
VOSEBN
VOGEEN

YV 10EGN
WV 10EEBN
WV 10EBN
WV 10EEN

1 2 3 4 5 6 7 8 9 10 11 1213 1415 16 17 18

Chassis #2

If you use an MOO36A Controller, you will need to install an additional M902TA PCle
interface in chassis 1, slot 2 to connect chassis 1 to chassis 2. In that case, VSA #1 will
need to occupy slots 3, 4, and 5.

Other module and instrument placements can be used, but this configuration
optimizes speed and makes cabling simpler for phase coherent configuration.

The M9300A PXle Frequency Reference must be installed in slot
10 for proper time synchronization between instruments. For more
information.

Cabling is different for time-synchronization-only (independent LO) configuration and
phase-coherent (shared LO) configuration. See the following sections for cabling
information:

Time-Synchronized, Multi-Channel PXI VSA & VSG (Independent LO)

When phase coherence is not required, cable the instrument as follows for time
synchronized multi-channel operation for independently tunable channels.

4x4 Independent LO Cable Connections:
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- Primary 100 MHz connection (8121-2175, long SMB-SMB)

Secondary 100 MHz and IF connections (8120-5091, short SMB-SMB)

Semi-rigids

_ = PCle cable (Y1202A)

Primary 100 MHz - 8121-2175 Semi-rigid - various PCIe Cable - Y1202A

AN KEVSIGHT — MSOTBA  vancas s
MRz,

KEYSIGHT MS018A  Advanced Switch Fabric
PXle Chassis

LLLLEELL EREEE  RRERREES

Phase-Coherent, Multi-Channel PXI VSA & VSG (Shared LO)

When the carrier phase must be aligned between channels (beamforming, relative
phase measurements), cable the instrument as follows:

4x4 Shared LO Cable Connections:
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- Semi-rigids

Step 4 -Install the Modules

Primary 100 MHz connections (8121-2175, long SMB-SMB)

Secondary 100 MHz & IF connections (8120-5091, short SMB-SMB)

_ . LO distribution connections (E6630-60004, SMA-SMA)

- - PCle cable (Y1202A)

- = Unused M9301A modules

Primary 100 MHz - 8121-2175

AV KEYSIGHT

Semi-rigid - various

PCIe Cable - Y1202A

Shared LO - E6630-60004  Unused M9301A

MS018A  Advanced Switch Fabric PR O OF
PXle Chassis
A o o o
= - —
« EvsiGHT
50A
i o
|G
ss<r | 5
! g 2
L]
1 Ao
@ ' )
KT (L1 i W . wEEn om
KEYSIGHT MS018A  advanced Switch Fabric O Ot O
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PRI A o (=) o (-] o o o | (] (2] ® [J () o @ (g
@EED (ms31iA M9310A 193014 ] M9311A M9310A (MS9307A  |M9300A |M9311A 93108 1A M9310A 19301A
M9Q2IA | Medser Soure Ot - SourceOupr [ Srthsizer [ Rtemte | Wodlator SourceOupn Soure Ot
L H e o o ) R R I I I - ) RO | T e (Y =
L e ~ Qe O & o e o R
el @ Al ) = 0 o . R\ e b Qe D
Dxaie ) wn
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® x8Chassis. £ .
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8x8 M939TA and M938TA Instrument Connections

A set of 8-channel M9381A PXle VSGs installed in two M9018A 18-slot chassis and a
set of 8-channel M9391A PXle VSAs installed in another pair of M9018A 18-slot
chassis can be configured for multi-channel testing by using a single (M9036A or
M9037A) embedded controller, MO021A PCle cable interface modules (6 with
M9036A and 5 with M9037A) and 3 PCle cables to connect the four chassis. Each
chassis has its own M9300A PXle Frequency Reference that is shared by all the
instruments in that chassis. The M9300A PXle Frequency Reference must be installed
in slot 10 of each chassis. For recommended configuration, the 10 MHz reference
signal for each pair of chassis (containing 8-channel M9381A or 8-channel M9391A) is
provided by the M9300A in the master chassis from the OCXO Out connector.
Alternatively, you can use an external 10 MHz reference signal. For recommended
configuration, the OCXO output is split and distributed to the two Reference modules
using equal length cables, as shown below. It s critical to synchronize chassis within
each chassis group if timing and/or phase synchronization is important to your
measurements. For more information on how to set up the 10 MHz reference, refer to
Synchronizing Multiple Chassis .

The M3037A embedded controller is recommended for multi-chassis configurations.
The MO036A embedded controller or standalone PC are both supported. Not all
standalone personal computers work with four chassis configuration. For a list of
personal computers that have been tested to be compatible with the M3018A
chassis, refer to PC Tested Configurations with PXI/AXle Chassis - Technical
Overview . Similarly, using M9037A or MO036A has several prerequisites. For more
information, please contact your local Keysight Technologies Inc. representative.

The Keysight M9021A PCle cable interface modules are connected from one chassis
to the other, as shown in the image below. In the M9381A chassis group, the Sync
connector of the first M3311A PXle Digital Vector Modulator of each chassis must be
connected to each other. Similarly, in the M9391A chassis group, the Sync connector
of the first M9214A PXle Digitizer of each chassis must be connected to each other.
Multi-channel operation requires proper configuration of the chassis backplane
trigger lines. The PXle VSGs or PXle VSAs can also be configured to be phase
coherent with Option 012 and by cabling all channels in the chassis group to use a
single M9301A PXle Synthesizer module via the M9381A Instrument Connections
(page 22). See the image below. Slot blockers and EMC filler panels are installed in
the empty slots.

The Multi-Channel PXle Config Utlity program will recognise the
module placement within each chassis, and whether the system is
cabled for shared or independent LO. Use the readings given by
this program with the diagrams in this manual to check for system
configuration accuracy.
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8x8 configuration with V2802A shared LO
Chassis #1 Chassis #3

Chassis #2 Chassis #4

The recommended 8x8 system is configured as follows:
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Chassis #1

V10EE6N
V10EEN
V10EEN
V10EEN

1 2 3 4 5 6 7 8 9 10 11 1213 1415 16 17 18

Chassis #2

V10EGN
V10EBN
V10EBN
V10EEBN

1 2 3 4 5 6 7 8 9 10 11 1213 1415 16 17 18

Chassis #3

VLEOBIN
VOSEGN
VOSEBN
VOSEBN
VOGEBN

1 2 3 4 5 6 7 8 9 10 11 1213 1415 16 17 18

Chassis #4
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VOSEG
VOSEGN
VOGEBN
VOSEBN

1 2 3 4 5 6 7 8 9 10 11 1213 1415 16 17 18

Other module and instrument placements can be used, but this configuration
optimizes speed and makes cabling simpler for phase coherent configuration.

The M9300A PXle Frequency Reference must be installed in slot
10 for proper time synchronization between instruments. For more
information, see Sharing the M9300A Frequency Reference.

Cabling is different for time-synchronization-only (independent LO) configuration and
phase-coherent (shared LO) configuration. See the following sections for cabling
information:
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Time-Synchronized Only, Multi-Channel PXle VSA & VSG
(Independent LO)

When phase coherence is not required, cable the instrument as follows for time
synchronized multi-channel operation for independently tunable channels.

8x8 Independent LO Cable Connections:

.— Primary 100 MHz connection (8121-2175, long SMB-SMB);chassis sync;
10 MHz distribution

- - Secondary 100 MHz and IF connections (8120-5091, short SMB-SMB);
trigger cables

- = - LO distribution connections; semi-rigids (W1312-20266 and W1312-
20267 for M9381TA VSGs and W1312-20237 for M9391A VSAS)

_ . - PCle cables (Y1202A)

- -— RF loopback
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Phase-Coherent, Multi-Channel PXle VSA & VSG (Shared LO)

Unlike the independent LO use case, phase-coherency requires the V2802A LO
Distribution Network to be placed between each pair of chassis. For more information,
refer to M9381A Instrument Connections (page 22).

When the carrier phase must be aligned between channels (beamforming, relative
phase measurements), cable the instrument as follows:

8x8 Shared LO Cable Connections:

-— Primary 100 MHz connection (8121-2175, long SMB-SMB); chassis sync;
10 MHz distribution

- - Secondary 100 MHz and IF connections (8120-5091, short SMB-SMB);
trigger cables

- - - LO distribution connections; Semi-rigids (V2800-20006, V2800-20008,
V2800-20009 for VSGs and V2800-20010, V2800-200011, V2800-20007 for
VSAS)

- —PClecables (Y1202A)

- -— RF loopback

- D— Unused M9301A modules
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Step b - Quick Start Measurements

This multi-channel reference solution is used in particular to test:

— Multi-antenna technigues that are used in diversity

— Spatial multiplexing multiple-in, multiple-out (MIMO)

— Beamformingin cellular and wireless LAN applications
For further details refer to www.keysight.com/find/pxi-mimo.
Multi-channel transmitter and receiver testing may require synchronization of
multiple signal generators and/or signal analyzers in time and frequency. For
example, wireless LAN transmitters can be measured by multiple receivers operating
atthe same frequency and with acquisition timing aligned, and receivers can be
tested using synchronized signal generators.
The M338TAVSG and M9391A VSA can be configured to operate in multi-channel
configurations with a shared 100 MHz frequency reference, and an independent, or
shared local oscillator (synthesizer) for each channel. This allows them to operate at
the same frequency for multi-channel operation, and at different frequencies for
modes in which multiple carriers are used, but baseband timing alignment is still
required.

For more information on LTE/LTE-A Multi-Channel Systems see:
- Solution Brochure 5991-4684EN
— Configuration Guide 5991-4647EN

Quick Start to First Measurement

This section is meant to help you get to a first measurement and confirm proper
operation of your equipment. All PXI modules should have been installed and cabled
up according to the previous sections. All required software should have been
installed as well.

The following instructions are applicable for any configuration up to the 8x8
configuration.

Connect your system into a “Loopback” configuration, where each VSG is connected
directly to its corresponding VSA.
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VSG-1 VSA-1

VSG-2 VSA-2

This will allow us to verify the operation of the VSGs and VSAs without any additional
hardware.

Start the Multi-Channel PXle Config Utility from your Start menu under All Programs
> Keysight > Multi-Channel Tools.

E'_T Windows Update
g KPS Wiewer
| Accessories
, Agilent
. Lgilent IWI Drivers Derna
, Agilent Signal Studio
Cocurments
| Games

. Google Chrorme Pictures
| Keysight
L BA93E
L. hA9391
M ELE
. Multi-Channel Tools
(] MO3818 WSE Correction Uitilitye:
(] MO301LANEA Carrection Ltility.e:
D Multi-Channel PxIe Config Utilit Dewvices and Prnters
(] WG MIMO Derno Utility.exe
L keysight 39600 Softuare 19.0 Default Pragrarms
) Keysight Command Expert
| Keysight Instrument Drivers Help and support

BALzic

Cornputer

Caontral Panel

‘ Back Wlindows Secu r'it‘_-,-'

| |Semth prograrms and files 2 | m

We will be using the Config Utility to:

— Configure the M9018A chassis backplane triggers to support device com-
munication

Keysight Y1299A-001 Reference Solution User's Guide 47



Step 5 - Quick Start Measurements

48

= Runany IF Flatness and LO Level alignments needed

— Run Self-Test on the complete system. This can take up to nine minutes on an
8x8 configuration.

— Setup a new Hardware Configuration in the 89600 VSA Software
- Verify VSG playback

The first time the Config Utility is started you will see the Pxi Enumeration window.

o= Pxi Enumeration El = @

Dioes thiz match vour physical configuration’?

Chazsiz: M30184 Chaszsis -
glat 1:

glot 2

glot 3: MA27 44 Digitizer

glot 4: MA3014 Senthesizer

glot 5: MA3508 Dovwn Corveerter
glot B M927 44, Digitizer

glot ¥ M33004 Sunthesizer

glot 8: 3508 Dovwn Corveerter
glat 9:

glot 10: k33004 Reference

glot 17: k32144 Digitizer

glot 12 MI3014 Synthesizer

glot 13 k33504 Down Corvverter
glot 14:

glot 15: k92144 Digitizer

glot 16; MI301A Sunthesizer

glot 17: k93504 Down Converter
glot 18:

m

Chazsiz: M30184 Chassis

glot 1:

glot 2 M93114 Modulataor

glot 3:

zlot 4: 337104 AF Output

glot B: MA3014 Senthesizer

glot B: +33714 b odulatar

glot ¥

glot 8: MA3104 RF Output

glot 3: MA3004 Sunthesizer -

[ ez ]| Mo || Cancel |

This is a text representation of all the PXI modules that are currently available to you
software environment. Verify that all modules installed into your chassis are
represented in the list. If any items are missing, click the ‘No’ button and follow the
instructions. Otherwise, click ‘Yes’.

You will now provide information on the physical configuration of the Config Utility.
Under the ‘Properties’ menu you will find the settings that reflect how you have
cabled your Synthesizer (M9301A) modules.
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- Multi-Channel PxJe Config Utility (ver, 2.2.5

File PIEEEEGESS Actions  Help
Stah Fun Chassis Trigger Configuration on Windows Startup

|

C Shared W35G L
Shared W36 LO with External LO Distribution

C Shared W54 LD

C/ Shared W54 LD with External LO Distribution
I

— Ifyou have cabled your system into a shared LO/Synthesizer configuration (all
VSGs are connected to the same M9301A module and all VSAs are connected
to the same M93071A module) then make sure you check ‘Shared VSG LO’ and
‘Shared VSA LO’ options.

= Ifyou are routing the LO Out of the M930TA modules into V2802A LO Dis-
tribution boxes, check the ‘Shared VSG LO with External LO Distribution’ and
‘Shared VSA LO with External LO Distribution’.

- Ifeach VSGand VSAis using its own independent M9301A Synthesizer mod-
ule, make sure none of the Shared LO options are checked

Once you have finished selecting LO options, click on the ‘Generate Configuration...’
button.

o= Multi-Channel PxIe Config Utility (eer, 2,3.5)
File  Properties  Actions  Help

Statuz Auto-Config Output | Self-T

Generate
Configuration. .

OO0 O

The ‘Select Multi-Channel Devices’ dialog window will be displayed. By default, all
VSGs and VSAs are selected to be part of the multi-channel configurations. Leave
everything selected for you configuration and click ‘OK’.
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P

ol Select Multi-Channel Devices

Select Mulb-Channel Devices

E=R(EcR <=
Fleaze select what devices are part of the multi-channel
configuration. Dezelected devices will be run

k33914 _weal_chazsiz]_slot3_5
k33914 _vear_chazsiz]_zlotb_3
k93914 _vza3d_chazsizl_zlot11_13
k33314 _vzad_chazsizl_slot15 17
33814 _waal_chazsis2_slot2_4
MI3814_wag2 chazsizZ_slotE_2
MI3814_wag3d_chazsizZ_slot11_13
MI331A_vagd_chazsis?_slot15 17

0K, |

Cancel

Ifyour VSGs or VSAs span multiple chassis, you will need to specify a device to be a
VSG System Master or VSA System Master in the ‘Select a VSG System Master’ or
‘Selecta VSA System Master’ windows respectively.

folo )

Select a5 from the below ligt to be the System

o' Select a WS4 Systern Master

b aster pleaze.

Select a Spzterm Master

k339141 _chaszzisl_slot3 &
[] M333 A1 _chassisZ_shatd 5

x|

Cancel
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If you are setting up a system with a shared synthesizer, you may also have to select
which synthesizeris being shared by either your VSGs or VSAs in the ‘Select a VSG
Synthesizer or ‘Select a VSA Synthesizer windows respectively.

a5 Select a WS4 Synthesizer E'@

Select a synthesizer fram the below lizt to be the W54
ghared LO pleaze.

Select a Synthesizer far shared LO

[7] Chazsiz 1 Slot 4
[] Chassiz 1 5lat 7
Chazsiz 1 5lat 12
[] Chassiz 1 Slat 16

I 0k I I Cancel J

Select the M93071A Synthesizer module that you cabled as your shared synthesizer
and click ‘OK’.

After you have finished with the dialog windows, a text output of the system settings
will be displayed in the ‘Auto-Config Output’ tab. Click ‘Apply’ to commit these
changes.

o= Multi-Channel Pxde Config Utility (ver. 2.3.5) [ @ ||
File.  Properties  Actions  Help

Status Auto-Caonfig Dutput | Self-Test Output | Code Shippet

Generate :Chaszziz [MI0T84] [chassiz 1] -
Configuratiar... Mame: chassis]
WISh address: PRI 0:0:INSTR
Trigger 1 routing: Buz Segment 1 to Bus Seament 2 to Bugz Segment 3
Apply Trigger 3 routing: Bus Segment 2 to Bus Segment 1
Trigger 4 routing: Buz Segment 3 to Bus Segment 2 to Bus Segment 1

m

Fiun Alignments... . )
Receiver [MI391A) chaszziz 1, slots 3-5:

Mame: M33914_vsal_chassis1_slotd 5

Self-Test VIS4 address: PRISZ00:INS TR PHIET 0000 NS TRPRI21 000 INS TR
Feceiver azzigned role of System Master

Synchronization tngger 1

Shared LO located at chassiz 1, zlat 7

Shared LO Port: 15

000 @

:Receiver [M33914) chassis 1. slots 6-82
Mame: MI3914_vsaZ_chazsiz]_slote_8

[ Fiun S ample ‘W aveform I WS4 address: PRISZ2:000:IMS TR P49 000 NS TR P52 00 NS TR
Receiver azsigned role of Slave
[ Configure 83500... I Synchronization trigger 2 -
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After clicking the ‘Apply’ button, the Config Utility will route the backplane trigger lines
to the M9018A chassis and configure the [MI300A reference modules based on your
configuration.

Click on the ‘Run Alignments...” button and follow the cabling prompts in order to
perform any IF Flatness and LO Level alignments needed by your system.

! Multi-Channel PxIe Canfig Ltility (e
File  Properties  Actions  Help

Status e
. Generate i
Configuration. . HE

W

Tri
O [ Fun Alignments...
O | SeltTest

Click onthe ‘Self-Test’ button. This will run self-test on all VSGs, VSAs, reference
modules, and chassis in your system. If self-test reports any errors with your system,
please see the corresponding M338x or M9391A documentation for help resolving the
Issues.

=R
Mz
WL
Fe=

|
® [ w7

|

1

g Multi-Channel PxIe Config Utility (eer, 2.3.5
File  Properties  Actions  Help

Status Ata-Canfi
. Eenerate :Chasziz

Configuratiar... Mame: ch

WISA add

Triager 4
. [ Run Alignments. ..
O | SelfTest

Receive
Marne; bt
W58 add
Receer
Synchnon
Shared [T

® - | =
)
1
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o' Multi-Channel PXIe Canfig Utility fwer. 2.3.5)

File.  Properties  Actions  Help

Statuz

Generate
Canfiguration...

Apply

Fiun Alignments...

Self-Test

[ Run Sample ‘W aveform ]

| Configue 83800... |

Auta-Config Output | Self-Test Output | Code Snippet

(o] & (=]

kchazsizl Self Test Results: [0x0) Self test passed

k93004 _refl_chazsiz1_slot10 Self Test Results: [0x0) Selftest passed
chazziz2 Self Test Results: [0x0) Self test pazsed

33008 _refl_chaszzis2 slot10 Self Test Results: [0x0] Selftest paszed
A3 _vzal_chassiz]_zlotad 5 Self Test Results: [0x0] Selftest passed
k93814 _weql_chassisZ_zlot?_4 Self Test Results: [0x0] Selitest paszed
MI3NA_vzas chaszsiz]_slotb 3 Self Test Results: [0x0] Selftest passed
A3 _vzad chassiz]_slot11_13 Self Test Results; [0x0] Selitest paszed
k93914 _wvzad chassis1_slot15_17 Self Test Results: [0=0) Selftest pazzed
MI3B1A_vege chaszsizz_slotb 3 Self Test Results: [0x0] Selftest passed
MI381A_vegd chaszsizZ_slot11_13 Self Test Rezultz: [0x0] Selitest paszed
MA38148_vegd_chassizZ_zlot15_17 Self Test Results; (080 Selitest paszed

After Self-Test completes, click on the ‘Configure 89600..." button.

.“f Fulti-Channel PxIe Config Utility (eer, 2,3.5)

File  Properties  Actions  Help

Status

Auto-Config Output | Self-Test Output | Code Snippet

chaszis1 Self Test Results: [0x0) Self test passed

M93008,_refl_chagzsiz]_slot10 Self Test Results; [0x0] Selitest paszed

cha

k)
)

ta] 85 WSA Configuration Narne EI =] @

M3 M ame: i utolE enerated
r49
M3 Auto-Calibrate:
b9
k49

'

Provide a name for the new Hardware Configuration that will be created by the Config
Utility in the 89600 VSA Software. Uncheck the ‘Auto-Calibrate’ checkbox, then click

‘oK.

The Config Utility will start the 89600 VSA Software, create the new Hardware
Configurations, and connect to the VSA hardware. Note: the 89600 Splash Screen
will not be displayed while the software loads.
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Step 5 - Quick Start Measurements

Z vVector - Keysight 83600 Y54, Software (64-bit)

File Edit Control Source Input  MeasSetup  Trace  Markers  SWindow  Utilities

Help

50% | 0%

ng 10

Colar Mormal

Acquiring Test...

A: Chl Spectrum

Measurement running

| mTrer || caL Hone
7 Vector - Keysight 89600 VSA Software (§4-bit) e =
File Edit Control Source Input MeasSetup Trace Markers Window Utilities Help @
[ R[] RVETIR Y. B =i R W M | 50% ] 0% | Color Normal

E: Ch1 Main Time

4“!\\'\;:\*‘“‘\'{‘1 .ﬁv-,-ﬂ..u-fr‘p'r‘mrur.w ""“'\W""‘"”"\‘#\"‘ u-..'w.ur\v\;,rnl“'-\ww P“(\'W‘.-u"f‘.ﬁVﬁ\']l‘l'W-\J“‘.N"MI‘I,"'rwﬁ[‘l{'n)“r,‘,‘pm,rﬁ"p -\.-m-

art 0

’ﬂ‘N‘Jﬁl‘ﬂfﬂ"‘r\’r}g"u‘a" T ﬁﬂnﬂ'{'ﬁ

. ,"Jr"“""'"”ﬂ""*‘l‘ .r‘*‘ﬁnrim'r.,hm'L,f

| T REF

AL Warm Up
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Step 5 - Quick Start Measurements

Click on ‘Run Sample Waveform’in the Config Utility. This will connect to the VSGs
and play a simple square wave.

o2 Multi-Channel Pide Config Utility tver, 2.3.5) = B [k
File  Properties  Actions  Help

Status Auto-Config Output | Self-Test Dutput | Code Snippet
. Generate chazzizl Self Test Results: [Ox0) Self test pazzed "
Canfiguration... R S3000,_ref_chazsis1_zlot10 Self Test Resuls: (0x0) Selftest pazzed
chassis? Self Test Results: [0=0] Self test paszed
s F 33000, ref1_chazsis?_zlot10 Self Test Results: (Ox0) Selftest pazzed
| Apply | F33914_wsal_chassis_slot3_5 Self Test Results: [0x0) Selftest passed

M I3814_vsgl_chassis2_slotz_4 Self Test Results: [0x0] Selftest paszed

| Fun Alignments... | MI3314,_wzaZ_chassizl_slote_3 Self Test Results: [0x0) Selftest passed
—_———— F33910, wead chasszigl_slot11_13 Self Test Results: [0x0] Selftest paszed
t33910_wsad chassisl_slot1h 17 Self Test Results: [0x0) Selftest passed

| M33874_wsg2_chassisZ_slotE_B Self Test Results: (0x0) Selftest paszed
r33310,_wegd chasgied #lot11_13 Self Test Results: [0x0] Selftest passed
t33818,_wagd chassis? slotlh 17 Self Test Results: [0x0) Selftest passed

[ SeliTest

| Run Sample waveform |

|  Configuessson. | -

After the VSGs begin playback, pause acquisition in the 89600 VSA Software.

2 Vector - Keysight 89600 VSA Software (64-bit) o (]
File Edit Control Source Input MeasSetup  Trace Markers Window Utilities Help (7]
b (10| Jan ~ - | @ | o =5~ R|“2 W [ P4 - R 50% ] 0% Color Normal
#: Chl Spectrum ~ E: Ch1 Main Time

B: ChZ Spectrum F: Ch2 Main Time
30 dBrn 0y

C: Chi Spectrum : Ch3 Main Time
230 dBm 0

Measurement paused | mrrer | [

Verify that the rising edges on each channel are aligned. Congratulations, you've
made your first multi-channel measurement!
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Quick Start to Beamforming Measurement (Shared LO
Only)

If you have just finished the previous section, click on ‘Stop Waveform’in the Config

k93914 _wvzad chassis1_slot11_13 Self Test Results: [0=0) Selftest paszed
I3 _vzad chaszsiz]_slot15 17 Self Test Rezultz: [0x0] Selitest paszed
Sel-Test MA3814_vegd_chassizZ_zlotE_3 Self Test Results: [0x0] Selftest passed

k93814 _weg3d chassisd_slot11_13 Self Test Results: [0=0) Selftest pazzed
MI381A_vegd chaszsizz_slot15 17 Self Test Rezultz: [0x0] Selitest paszed

Utility.
o= Multi-Channel PXIe Config Utility (ver, 2.3.5) =] = 5]
File Properties  Actions  Help
Statusz Auto-Config Output | Self-Test Output | Code Snippet
. Generate chazziz] Self Test Results: [0x0) Self test pazsed -~
Configuration... p33008_ref_chaszsis1_slot10 Self Test Results: [0x0] Selftest paszed
chasziz? Self Test Resultz: [0x0] Self test pazzed
k93004 _refl_chazsiz?_slot10 Self Test Results: [0x0) Selftest passed
MI39A_vzal_chaszsiz]_slot3d 5 Self Test Results: [0x0] Selftest passed
MA3814_vegl_chassizz_zlotZ_4 Self Test Results: [0x0] Selftest passed
. MI3914_vea?_chazsisl_sloth_B Self Test Resuls [0x0) Selftest passed

Stop ‘whavefarm ]

Corfigure 89600.. | -

You will need to re-cable your system into a “Loopback” configuration where each
VSG and VSA has its own, independent RF cable. RF cables can then be connected
through an adapter in order to create the loopback.

VSG-1 VSA-1
[r— §
\
>Ada pters
VSG-2 L MSA |
| —— ﬁ
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Step 5 - Quick Start Measurements

From the ‘Actions’ menu, select the ‘Save Device Aliases by New Name and
Channel...” option.

gl Multi-Channel PXIe Config Utility (ver, 2.3.5)

File  Properties PRfEdEiEs Help
Status Save Device Aliases by Configured Mame EL
. & Save Device Aliases by Mew Mame and Channel...
Caonl Delete &)l Device Aliases L0

. : Start WSG SCPI Server... Eg]
k]

Configure WG SCPT Server.., [0
. | Run £ (L
Save Output from Selected Tab.. |
[ I e b S S S S

Inthe ‘Save SCPI Aliases’ window, type “VSG” into VSG Base Name’. Leave VSA
Base Name’ empty and click ‘Save’.

82 Save SCPI Aliases =]

W35G Base Hame  WSG '

W54 Baze Name |

[ Save ] [ Cancel ]

Go back to the ‘Actions’ menu and select ‘Start VSG SCPI Server...’

gl Multi-Channel PXIe Config Utility (ver, 2.3.5)

File  Properties PRfEdEiiy Help

Status Sawve Device Aliases by Configured Mame EL

. E Save Device Sliases by Mew Mame and Channel..,
Conl Delete All Device Aliases <]
. : Start W/SG SCPI Server... EEL
Configure WG SCPT Server.., [0
: @ Save Output from Selected Tab.. [SDH[

[

L P P T o [ 3 2 Y LW P e | S ) Y SZ[
\

CalET—nk ] | e - B A .
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58

Inthe ‘Start VSG SCPI Server’ select ‘VSG’ as your ‘Alias Base’ (the value you entered
into the 'VSG Base Name’ text boxabove). Leave HiSLIP selected and click ‘Start’.

Start WEG SCPI Server

-,

=

Aliaz Baze:  |WSG

i |

Frotocol; @ HiSLIP
Sockets

Telnet

Starting Part: | 5025

Start | | Cancel |

Wait for all of your VSGs to start in the SCPI server console window, and do not close

the window.

B C:\Pragram Files (xB6)4AgilentihI38\bin\Agh I3 BxScpi.exe

Started device hisliph which binds to USG-6
Started device hislip? which binds to USG-7
Started device hislip8 which binds to USG-8

Press 'R’ to exit

Open the ‘Actions’ menu again and select ‘Configure VSG SCPI Server...’

oz Multi-Channel PxIe Config Utility feer, 2.3.5)

File  Properties

Statuz

Help
Sawve Device Aliases by Configured Mame
Save Dewice Aliases by Mew Marme and Channel..,

Delete All Dewice Aliases

Start W35G SCPI Server..,
Configure W5G SCPI Server...

Sawve Dutput frorm Selected Tab...

=[]

<]
[0
[
[0

@ |
. | Fiun £
dh

I CAlE T~

| i e S P o T T = b L ) =] =TS0 10 JE TEL TS

3
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Step 5 - Quick Start Measurements

Leave HiSLIP selected and click ‘Configure’. After the success dialog is displayed,
click ‘OK’

b s as s =N EER =<

Praotocal; @ HisLIP

1 Sockets

Starting Part:| 5025

Configure ] [ Cancel

SUCCESS @

:I SCPI Configuration Success!

If your system is a 4x4 or an 8x8 system, connect the 10 MHz Out of the M9300A for
the VSA chassis and connect it to the M9300A Ref In for each VSG chassis. 4x4
systems can accomplish this by a direct connection; for 8x8 systems, you will need to
disconnect the OCXO Out cable for the VSG chassis and connect it to the 10 MHz Out
of the M9300A for a VSA chassis. Open the M9300A Soft Front Panel in each VSG
chassis and check ‘Use External Reference’.
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File View Utilities Tools Help
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M9381A VSG Correction

Step 5 - Quick Start Measurements

Start the M9381A VSG Correction Utility from your Start menu under All Programs >
Keysight > Multi-Channel Tools. You will use this tool to measure the time and phase
offsets between your VSGs. Later, this data will be applied to the VSGs in order to

align them.

E_T Windows Update
o MPE Viewer
. Accessaries
, Agilent
 Agilent TV Drivers
, Agilent Signal Studio
, Garnes
, Google Chrome
| Keywsight
IR
L hA9391
L
L Multi-Channel Tools
] M93814 %S5 Correction Litility. e
] MO30LA NS Carrection Litility.e:
] Multi-Channel PxIe Config Utilit
] WG MIMO Dermo Utility.exe
| Keysight 39600 Softuare 19.0
| Keywsight Command Expert

 Keywsight Instrurment Drivers

1 Back

Segrch rams gnd filss
prog P

Derna

Docurments

Pictures

fusic

Cornputer

Contral Parnel
Dewvices and Printers
Default Pragrarms
Help and Support

Weindous Security

BCTT e
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62

5] M93815 Correction Utility =N ol =<

Mumkber of Y53 Channels:| & -

W3G IF Address: localhost

Cancel | Mext |

In the dropdown box, select the number of VSGs that were started in the SCPI server
console window (the example picture has 4). Leave VSG IP Address as ‘localhost’ and
click ‘Next’. The Correction Utility will then connect to the VSG SCPI server.

Select the 89600 session radio button option and click ‘Next’. Make sure you still have
the 89600 VSA Software session open from the previous section (if not, start the
89600 VSA Software now and connect to the hardware configuration you created in
the previous section). Then click ‘Next’ again.
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Step 5 - Quick Start Measurements

5] M93814 Correction Utility == EoR =

() M9391A direct connection
@) 20600 session ;

Cancel | [ Previous | [ Mext |

B MO3818 Carrection Utility E=n Bl =

Please setup the 89600 software to connect to the VSA that will be used to align the V5Gs

Cancel | [ Previous | | Mext |

You will then need to select the signal combiner size you will be using to correct the
VSGs. You will also need to re-cable your system with the combiner. For more

information on splitter and combiner considerations, please see the User’s Guide.
Select ‘Next'.
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64

Combiner Size:

These are the currently defined bands that you will be testing. Te add more, select from the
links below,

Import from file...

Center Frequency (MHz) Sample Rate (MHz) Amplitude (dBm)

Remove Selected Bands Add Ancother Band

e ] [ — Next ==y
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Step 5 - Quick Start Measurements

On this page, click on ‘Add Another Band’ in the lower right hand corner. For example
enter “1000” for the center frequency, 15.36 for the sample rate, and -10 for the
amplitude. Then select ‘Next’ twice.

5] M93814 Correction Utility == EoR =

Center Frequency (MHz): 1000

Sample Rate (MHz): 15.36
Amplitude (dBm): -1q
Cancel l [ Previous l [ Mext l

B MO3818 Carrection Utility E=n Bl =

These are the currently defined bands that you will be testing. To add more, select from the
links below.
Import from file...

Center Frequency (MHz) Sample Rate (MHz) Amplitude (dBm)
1000 |15.36 |-10 |
Remove Selected Bands Add Ancther Band
Cancel l [ Previous Mext

You will then need to follow the diagram to re-cable your system to include the
combiner. Disconnect your RF cables from the adapters and add the combiner as
indicated. The VSA in the diagram is your VSA channel 1 (the VSA assigned the role of
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Step 5 - Quick Start Measurements

System Master in the ‘Auto-Config Output’ tab in the Config Utility). Then select
‘Next'.

1) MO3818 Correction Litility ==

Follow the diagram to connect the specified VSGs to the V5A, Make sure nothing besides what
is indicated is connected.

VSGs VSA

Channel Number
GO = & L1 o W ha
Combiner

Cancel | Mext

The Correction Utility will then measure the time and pahse differences between your
VSGs. If your combiner doesn’t have enough inputs for each VSG, you will have to re-
cable.

| MI3EL8 Correction Utility =2 Ech=<

Generating corrections...
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Step 5 - Quick Start Measurements

Follow the diagram to connect the specified VSGs to the VSA. Make sure nothing besides what
is indicated is connected.

[ Ganeel | [ Previous | [ Newt | Finish

X |- [
Follow the diagram to connect the specified VSGs to the VSA. Make sure nothing besides what
is indicated is connected.

[ Ganeel | [ Previous | [ Newt | Finish

You have finished your carrections
Click here to save to file.

Cancel | | Previous | | Net | [guFinishy)
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Step 5 - Quick Start Measurements

Save the results by clicking the link in the center of the window. Then click ‘Finish’.
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M9391A VSA Correction Utility

Step 5 - Quick Start Measurements

Start the M9391A VSA Correction Utility from your Start menu under All Programs >
Keysight > Multi-Channel Tools. You will use this tool to measure the time and phase
offsets between your VSAs. Later, this data will be applied to the 89600 VSA

Software in order to align them.

E_T Windows Update
o MPE Viewer
. Accessaries
, Agilent
 Agilent TV Drivers
, Agilent Signal Studio
, Garnes
, Google Chrome
| Keywsight
IR
L hA9391
L
L Multi-Channel Tools
] M93814 %S5 Correction Litility. e
] MO30LA NS Carrection Litility.e:
] Multi-Channel PxIe Config Utilit
] WG MIMO Dermo Utility.exe
| Keysight 39600 Softuare 19.0
| Keywsight Command Expert

 Keywsight Instrurment Drivers

1 Back

Segrch rams gnd filss
prog P

Derna

Docurments

Pictures

fusic

Cornputer

Contral Parnel
Dewvices and Printers
Default Pragrarms
Help and Support

Weindous Security

BCTT e
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Step 5 - Quick Start Measurements

= M83918 Correction Litility

Launch 83600 Monitar |

Launch Correction Wizard |

Select the ‘Launch Correction Wizard’ button. Select the number of VSAs that make
up your Hardware Configuration in the 89600 VSA Software. Select ‘89600 session’
as the VSA Connection Type and select ‘Next’ twice.

5] M9391 Correction Utility

Number of VSA Channels:
V5A Connection Type:

Cancel |

8 -
2 M9391A direct conr

©189600 session.

Mext |

=N o =)

Your 89600 will be configured to run correction measurements.
Leave ‘localhost’ as the VSG IP address and HISLIP as the VSG Connection Type and

click ‘Next'.

70
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5] M93914 Correction Utility == EoR =

W55 IP Address: localhost
W5G Connection Type:@ HiSLIP
7 Socket

Maote: This connects to HISLIP 1/ Socket port 3025.

Cancel l [ Previous ] [ Mext

You will then need to select the signal splitter size you will be using to correct the
VSAs. For more information on splitter and combiner considerations, please see the
User’s Guide. Select ‘Next'.

| MI38L8, Correction Utility = Ech <

Splitter Size:

Cancel Previous Mext
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72

These are the currently defined bands that you will be testing. Te add more, select from the
links below,
Import from file..,

Center Frequency (MHz) 5Sample Rate (MHz) Amplitude (dBm)

Remowve Selected Bands Add Another Band

Cancel ] [ Previous Mext Finish
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On this page, click on ‘Add Another Band’ in the lower right hand corner. For example,
enter “1000” for the center frequency, 15 for the sample rate, and 8 for the amplitude.
Then select ‘Next’ twice.

5] M93914 Correction Utility == EoR =

Center Freguency (MHz): 1000
Sample Rate (MHz)™ 15
Amplitude (dBm): El

(*) For the M9391A VSA in the 89600 software, the sample rate is equal to 1.25 times the span.

Cancel | | Previous | [ Nea |

B MO3018 Carrection Utility E=n Bl =

These are the currently defined bands that you will be testing. To add more, select from the
links below.
Import from file...

Center Frequency (MHz) Sample Rate (MHz) Amplitude (dBm)
1000 |15 E |
Remove Selected Bands Add Ancther Band
Cancel l [ Previous Mext
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You will then need to follow the diagram to re-cable your system to include the
combiner. The VSG in the diagram is your VSG channel 1 (the VSG assigned the role
of System Master in the ‘Auto-Config Output’ tab in the Config Utility). Then select

‘Next'.
5] MO3818 Correction Litility ==

Follow the diagram to connect the specified VSAs to the V5G. Make sure nothing besides what
is indicated is connected.

VEAs VSG

Splitter

Channel Number
(== IS = L, B VRN (E R

Cancel |

The Correction Utility will then measure the time and phase differences between your
VSGs. Ifyour combiner doesn’t have enough inputs for each VSG, you will have to re-

cable.

| MI3818, Correction Utility =2 Ech=<

Generating corrections...
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Follow the diagram to connect the specified VSAs to the WSG. Make sure nothing besides what
is indicated is connected.

[ Ganeel | [ Previous | [ Newt | Finish

X |- [
Follow the diagram to connect the specified VSAs to the WSG. Make sure nothing besides what
is indicated is connected.

[ Ganeel | [ Previous | [ Newt | Finish

You have finished your carrections
Click here to save to file.

Cancel | | Previous | | Net | [guFinishy)
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Save the results by clicking the link in the center of the window. Then click ‘Finish’.
Select the ‘Launch 89600 Monitor’ button.

203018 Correction Utility E=x Bl =

| Launch 83500 Monitor |

Launch Carrection Wizard l

5] M93914 Correction Utility == EoR =

File

Center Frequency (MHz) Sample Rate (MHz) Amplitude (dBm)

Select a band Corrections OFF
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Go to the ‘File’ menu and select ‘Open’. Open the VSA corrections file you saved in the
previous step. You should now have the correction data you generated previous
available in the table.

5] M93914 Correction Utility =N ol =<
File
Center Frequency (MHz) Sample Rate (MHz) Amplitude (dBm)
1000 |15 E |
Select a band Corrections OFF

Re-cable your system into the “Loopback” configuration with the adapter between
the cables from the VSG to the VSA.

VSG-1 VSA-1
[r—— ﬁ
\
>Ada pters
VSG-2
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78

Load in the appropriate beamforming setup file in the 89600 VSA Software by
selecting the File menu > Recall, Recall Setup... then navigating to the Multi-Channel
Utilities install location and going to Setup Files/LTE/{Dual Channel | Four Channel
(depending on your channel count)}/LTE-TDD10MHz_XxXbeamforming_1GHz.setx.
Load that file by clicking ‘Open’.

E Wector - Keysight 39600 Waa Software (6 4-hit)
File | Edit Control Source  Input  MeasSetup  Trace  Bdarkers  'Windo

v Recall r Recall Setup...

Preset ] Recall Recarding... .
= Save 3 Fecall Trace...

Copy Trace.. Recall Last Power-dowen Setup .

Recall Signal Studio Setup..,
== Print.., Ctrl+P Recall Layout...
Exit Alt+Fd Recall Display Preferences...

Start-3.423 uSec

Recall User Calor Map...

Recall Demao..,

B: Ch2 Raw bdain Time

E Recall Setup

Lok jr: | , Four Channel j & &5 Bl
L= Mame = Date modified Type
g
st 7| eAMIMO_SMHzBw_Carrier_GHz_OLSM.sete  4/10/2015 3:53 PM SETXFile

Fecent Places K .
7] 4 dhAIMAO_10MHzBwe_Carrier_2GHz_OLSM.sete 471072015 352 Ph SETX File

[ ] 7] cAMIMO_20MHzBw_Carrier_2GHz_OLSM.sebe 4/10/2015 354 PM SETXFile
Desktap |7 InterBand10MHzBYW _2CC_2x2_750_2100MHz.. 4/24/2014 £03 PM  SETXFile
fOTITETDDIIMH 8x8 Beamform 1 Grzsete  5732/2015 G:48 AN SETX File

=}/
Libraries

A

=

Computer

Y
w
Metwark

4 n L3

File name: |LTE-TDD‘I OhHz_d4x4Beamform_1 GHz zetx ﬂ Open |
Files of type: | State Files [* setw, "set) ~| Cancel

VSG MIMO Demo Utility

Start the VSG MIMO Demo Utility from your Start menu under All Programs > Keysight
> Multi-Channel Tools. This tool is used as a soft front panel for multi-channel VSGs.
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E_T Windows Update
i KPS Wiewer
, Mrcessories
 Agilent
o Agilent TV Drivers Derna
, Agilent Signal Studio
. Games Docurments

, Google Chrorme Fictures
| Keysight
L BA938x
L hA9301
M ELE
. Multi-Channel Tools
(] MOIRLANSS Correction Ltilitye:
] bA93918 %58 Correction Ltility.e:
D Multi-Channel PxIe Config Utilit Devices and Printers
(] WSG MIMO Dermo Utiliby.exe
. Keysight 83600 Software 19.0 Default Programs
) Keywsight Command Expert
| Keysight Instrument Drivers Help and support

Bdusic

Cornputer

Cantral Panel

‘1 Back WETnd o

| |Semth prograrms and filss B2 | m
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o5 IMODemaiGLUI

Setthe # of VSG Channels’ to the number of VSGs running in the SCPI server, make
sure ‘Write Changes to HW on Init’ is checked, leave ‘localhost’ as the TCP-IP
address, and click ‘Init’.

80

W aveform Config FileM ame

Hardware Configuration |Wavefu:urms I [Fenerator Settings

# of WSGE Channels TCP-IP address

= localhost
[] Simulated Hardweare Wwiite Changes to Hw on Init
[] Send erraor queries toWSG [] Log SCPI commands

Go to the ‘Waveforms’ tab and select the ‘Load Waveforms From Config File’ button.

= Configuration | aveforms | Generatar Settings|

|zer W avetarms

Waveform Alias Load zer
W aveform Files

Chan 1 FileM ame

Chan 2 FileM arne
Chan 3 FileM ame
Char 4 FileM arne
Chan & FileM arne
Charn B FileM arne
Chan 7 FileM arne
Chan 8 FileM ame

Load ‘W aveforms
Fram Caonfig File
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Then navigating to the Multi-Channel Utilities install location and going to Setup
Files/LTE/{Dual Channel | Four Channel (depending on your channel count)}/LTE X-
channel waveforms.csv. Load that file by clicking ‘Open’.

5 Selectwaveform config file @
@n\:—/nv| € Program Files (x86) » Keysight » Multi-Channel Tools » Setup Files » LTE » Four Channel - |$¢ || Bearch Four Channel p'
Organize * Mew folder = ~ [ IZ@I

Marme . Date modified Type Size

- Favorites
Bl Desktop LTES-channel waweforms.cav 41072015 1120 AW OpenOffice.org L., 2KE
& Dowenloads

2 Recent Places

o Libraries
3 Docurnents
Jv- Music
= Pictures

B videos

1M Computer
‘:-_-’1. SysternDrive (C2)

o RecoveryPartition (E

Gi_d Metwark

File name: LTE 4-channel waveforms,csw - ’Comma—Separatedﬁles ¥ v]

[ open |+ [ conce |

Using these waveforms do require a signal studio license. You can get a temporary
license from:

www.keysight.com/find/free_trials
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Go to the ‘Generator Settings’ tab. Setall frequencies, amplitudes, IQ delays, and 1Q
phases for each channel number (up to the number of channels in your system) to
1000, -10, 0, and O respectively. Note: you may need to uncheck ‘Track Frequency
Changes’and ‘Track Amplitude Changes’ to accomplish this.

Hardware Canfiguration | Wavefnrms| Generator Settings |

RF/Baseband settings | Playback/Trigger Settings|

RF Settings

Track Frequency Changes
Chan 1 Freq Chan 2 Freq

1,000,000 F={Hz (1,000.000
Chan & Freq Chan & Freq
5200000 F-{MHz |5,200.000

Track Amplitude Changes
Ch1 Amplitude ChZ Amplitude

-10.00 = dBm -10.00 :
Ch5 Amplitude ChE Amplitude
-2.00 “ dBm |-2.00

FiF Enable
Bazeband Adjustments

Chan 110 Delay

Chan 110 Phaze

82

dBm |-2.00
todulation Enable (] Marrow Bw PLL

Chan 2 10 Delay

0.0ao Slpz 0,000 = |pz
Chan 510 Delay Chan & 10Q Delay
0.000 “|lps |0.000

Chan 2 10 Phaze

0.000 = |deqg | 0.000 =|deg
Chan 5 10 Phaze Chan B 10 Phaze
0.000 |deg (0,000

Chan 3 Freq

1.000.000 = MHz

Chan 7 Freq

5,200,000 = MHz

Ch3 Amplitude

-10.00 “ | dBm

Chy Amplitude

Chan 310 Delay

0.0ao = |pz
Chan 710 Delay
0000 ~pz

Chan 310 Phaze
0,000 = deg
Chan 7 10 Phasze
0,000 *deg

dBm

ALC Settings
[] ALE Enabled

Chan 4 Freq S5 o

1,000,000 - MHz '

Chan & Freq Track on Marker
B.200.000 - MHz Hald an Marker
Chd Amplitude FPulzz Blank Mode
-10.00 “| dBm @ 0

Cha Amplitude () O with Marker
—10 | dBim ) Off with Marker

Chan 4 10 Delay

0.000 = |pz
Chan 810 Delay
0.000 ~|pz

Chan 4 10 Phaze

0.000 =|deg
Chan 8 10 Phaze
.000 “|deq
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Step 5 - Quick Start Measurements

Select LTE-TDD10MHz_XxXBeamform’ in the ‘Select Waveform box and click ‘Play
Waveform’.

Select ‘W aveform:

IO _10kHz -
IMO0_SkHz

MIMO_20kHz

[HterB and2s2

LTE-TDD10MHz_dxdBearmform

Flay ' aveform
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Step 5 - Quick Start Measurements

Look at your 89600 VSA Software window. You will see an uncorrected beamforming

example.

2 LTE Advanced - Keysight B0600 VSA Saftware (64-bit)
File Edit Control Source Input MeasSetup Trace Markers Window Utilties Help
P00 Uan - . @ = B R B ¥ H M I || 5% || 0% | Color Normal

A:LayerD OFDM Meas (€C0) ~ K:Layerl OFDM Meas (CC0) P Layer2 OFDM Meas (CCl)

Ring 8 dBm
15

Canst

D: Error Summary (CCO)

i Layer: OFDM Meas (CCl) F: Frame Surnmary (CCO) E: OFDM MIMO Info (C.CO)

k. (ppr
a.(Ha)
inlrab.(dE)

QuadErr.(d:

a(
ainirb.(dB)
uadEr.(d

: Layerl Antenna Combined Beam Pattern (GCO)  H; Layerl Antenna Combined Beam Pattern (CC0) I Layer2 Antennia Gombined Bearn Patter (CCOY

84
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Step 5 - Quick Start Measurements

Bring your M9391A Correction Utility back up, select the single item in the table and
click ‘Apply’. This will apply the corrections to your VSAs so that your VSAs are
aligned. This operation may take up to a minute.

5] M93914 Correction Utility == EoR =

File
Center Frequency (MHz) Sample Rate (MHz) Amplitude (dBm)
1000 15 8
Apply
Click *Apply’ to apply correction Corrections OFF

B MO3018 Carrection Utility E=n Bl

File
Center Frequency (MHz) Sample Rate (MHz) Amplitude (dBm)
1000 |15 E |
Applying corrections... Corrections OFF
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86

= M83918 Correction Litility

File

Center Frequency (MHz) Sample Rate (MHz) Amplitude (dBm)

1000

|15 E |

Corrections ON

Now bring the VSG MIMO Demo Tool back up and click the ‘Load Alignments’ button.
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Step 5 - Quick Start Measurements

- MIMODernoGUL

| Hardware Configuration I waveforms | Gererator Settings |

RF/Baseband settings | Playback/Trigger 5 ettings

RF Settings

Track Frequency Changes

Chan 1 Freq Chan 2 Freq Chan 3 Freq
1.000.000 = (MHz [1.000.000 = MHz [1.000.000 - MHz
Chan 5 Freq Chan B Freq Chan 7 Freq
5.200.000 |=|MHz |5.200.000 % MHz |5.200.000 = MHz
Track Amplitude Changes

Ch1 Amplitude Ch2 Amplitude Ch3 Amplitude
-10.00 2| dBm |-10.00 dEm |-10.00 “ dEm
Ch3 Amplitude ChE Amplitude Ch? Amplitude

-2.00 | dBm |-2.00 dBr |-2.00 ~ dBm

Modulation Enable [¥] Narow Bw PLL

FF Enatle

Bazeband Adjustments

Chan 110 Delay Chan 2 I3 Delay Chan 313 Delay
0.000 pz 0000 2 pz 0000 = pz

Chan 510 Delay Chan § [0 Delay Chan 710 Delay
0.000 “ps 0,000 “|lps |0.000 s

Chan 110 Phaze  Chan 2|0 Phaze
0.000 2 deg |0.000 2 |deg |0.000 2 deg
Chan 510 Phase  Chan 610 Phase Chan 7 1) Phase

0.000 “lldeg |0.000 “lldeg |0.000 *|deg

Chan 310 Phaze

Baseband Alighments FileMame

ALC Settings
[] ALC Enabled

Chan 4 Freq :

1.000.000 [+ MHz @ i

Chan & Freq Track on Marker
5.200.000 - MH= Hald ok Marker
Chd Amplitude Pulze Blank Mode
-10.00 | dBm @ Off

Chi Amplitude () On with Marker
2 - dBrm ©) O vith Marker

Chan 4 [0 Delay

0.000 = ps
Chan 8 [0 Delay
0.000 *ps

Chan 410 Phaze
0.000 2/ deg
Chan & 10 Phase
0.000 *|deg

Load Alignments

Load D efault
Settings

Fead Settings
From Hw

‘wiite Settings ta
Hiws

Select Waveform:

MIMO_10MHz
MIMO_SkHz
MIMO_Z0mMHz
InterB and2x2
LTE-TCD10MHz 4

Flay ' aveform

Select Sequence:

Flay Sequence

l Update ‘waveforms l l D elete ‘Waveforms l

Mo Error Waveform Playback Initiated

Select the VSG corrections file you saved previous while running the M938TA
Correction Utility and open it. Correction data should automatically be loaded into

the tool.
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Step 5 - Quick Start Measurements

- MIMODemoGL

| Hardware Configuration I W aveforms | Gererator Settings |

FF/Baseband settings | Playback/Trigger 5 ettings

RF Settings

Track Frequency Changes

Chan 1 Freq

1.000.000 == MHz |1.000.000

Chan 5 Freq
5,200.000

~[MHz |5,200.000

Chan 2 Freq

Chan & Freq

Track Amplitude Changes

Ch1 Amplitude
-10.00
Ch& amplitude

-2.00 | dBm 200

FiF Enable

2| dBm |-10.00

Ch2 Amplitude

ChE amplitude

Baseband Adjustments

Chan 118 Delay

0.000 = pz
Chan 510 Delay
0.000 *ps

Chan 110 Phaze
0.000 2 deg
Chan 510 Phaze
0.000 *|deg

Chan 2 [0 Delay

23918 = ps
Chan B [0 Delay
0.000 “lpz

Chan 2 10) Phaze
13.325 2 deg
Chan 610 Phaze
0.000 *|deg

Bazeband Alighments FileMame
AU serg\DemohDeskloptWSGE_Corections. caw

~ MHz

“ MHz

dBm

dBm
Modulation Enable [¥] Marow Bw PLL

Chan 3 Freg
1.000.000
Chan 7 Freq
5,200.000

Ch3 Amplitude
-10.00

Ch7 amplitude
-2.00

= MHz

= MHz

dBm

dBm

Chan 318 Delay

186372 =

ps

Chan 710 Delay

0.000

s

Chan 310 Phaze

imz B

deg

Chan 7 1) Phaze

0.000

- |deg

Chan 4 Freq
1.000.000 = MHz
Chan 8 Freq
5,200.000 | MHz

Chd Amplitude
-10.00 ~| dBm
Cha amplitude
-2.00 ~ | dBm

Chan 4 1Q Delay
214737 = ps
Chan 8 10 Delay
0.000 *lps

Chan 410 Phaze
101 2/ deg
Chan & 10 Phasze
0.000 *|deg

Load Alignmments

ALC Settings
] &LC Enabled

@ 0o
Track on Marker

Hold on Marker

Pulse Blank Mode
@ 0K

() On with bMarker
() O waith b arker

Fiead Settings
From Hwf

Load Default
Settings

‘wiite Settings ta
Huws

[E=5[E=E =<
Select Waveform:
MIMO_10MHz -
MIMO_SkHz
MIMO_Z0MHz
InterB and2x2

LTE-TDDT0MHz 4

Play '\ avefarrn

Select Sequence:

Flay Sequence

l Update Waveforms l l Delete Waveforms l

Mo Error Finished loading alignments

88

Go back to the 89600 VSA Software. After applying corrections to both the VSGs and

VSAs, your beamforming waveform should now be corrected and look similar to
below.
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Step 5 - Quick Start Measurements

2 LTE Advanced - Keysight 89600 VSA Software (§4-bit) == =
File Edit Contiol Source Input MeasSetup Trace Markers Window Uilies Help w
Pl [ TUan v . ;@)= N RI“h W PR | 50% 0% Color Normal

A:Layer0 OFDM Meas (CC0) ~ K Layerl OFDM Meas (CCO) P Layer2 OFDM Meas (CGO) i Layer3 OFDM Meas (CCO) Fi Frame Surnmary (GCD) E: OFDM MIMO Info (GCO)

: Ch7 Spectrum  H: Layerl Antenna Combined Bearn Pattem (CE0) I Layer CCO Antenna Combined Bearn Patternd

hs Spectrum

D: Error Summary (CC1)

© = € ) I =] =] - S0

Quick Start to MIMO Measurement (Independent LO)

This section assumes you have completed the ‘Quick Start to First Measurement’
section, but you did not perform the ‘Quick Start to Beamforming Measurement’
section.

If you have just finished the previous section, click on ‘Stop Waveform’in the Config
Utility.
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Step 5 - Quick Start Measurements

a5 bulti-Channel PXIe Config Lility feer, 2,35
File.  Properties  Actions  Help

Staop YW aveform ]

Corfigure 89600.. |

I3 _vzad chazsiz]_slot11_13 Self Test Rezultz: [0x0] Selitest paszed
A3 _vzad_chassiz]_slot15_17 Self Test Results; (080 Selitest paszed
Self-Test k93814 _wveg2_chaszsisd_szloth_8 Self Test Results: [0x0] Selitest paszed

MI381A_vegd chaszsizZ_slot11_13 Self Test Rezultz: [0x0] Selitest paszed
MA38148_vegd_chassizZ_zlot15_17 Self Test Results; (080 Selitest paszed

Status Self-Test Output | Code Snippet
. Generate chasziz] Self Test Fesultz: [0x0] Self test pazzed
Configuratiar... p33008_ref_chasszis1_slot10 Self Test Results: [0x0) Selftest paszed
chazziz? Self Test Results: [0x0) Self test pazsed
33008 _refl_chaszzis2 slot10 Self Test Results: [0x0] Selftest paszed
A3 _vzal_chassiz]_zlotad 5 Self Test Results: [0x0] Selftest passed
k93814 _weql_chassisZ_zlot?_4 Self Test Results: [0x0] Selitest paszed
. MI3NA_vzas chaszsiz]_slotb 3 Self Test Results: [0x0] Selftest passed

From the ‘Actions’ menu, select the ‘Save Device Aliases by New Name and

Channel...” option.

g Multi-Channel PXIe Config Utility (ver, 2.2.5)

File  Properties PR Help

Statuz

Save Device Aliases by Configured Mame

Sawve Device Aliases by Mew Marme and Channel..,

ﬂ_

Delete All Device Aliases <]

. : Start WSG SCPI Server... Eg]
b

Configure WG SCPT Server.., [0

. Run £ (0=
Save Output from Selected Tab.., |

. [ Crlk T ok | S L D B U L “',Sn:[

Inthe ‘Save SCPI Aliases’ window, type “VSG” into VSG Base Name’. Leave VSA
Base Name’ empty and click ‘Save’.

o5 Save SCPI Aliases

YW5G Base Hame  W5SG

[ &S]

W54 Baze Name |

Save

] [ Canecel

Go back to the ‘Actions’ menu and select ‘Start VSG SCPI Server...’

90

Keysight Y1299A-001 Reference Solution User's Guide




Step 5 - Quick Start Measurements

@ Multi-Channel Pxle Config Utility fver, 2,35

File  Properties EEdEEY Help

Stahuz Sawe Device Aliases by Configured Mame £|_

. 5 Sawve Dewvice Aliases by Mew Marme and Channel..,
Coril Delete All Dewice Mliases «(]
. C_ Start WG SCPI Server.., Egl
Configure W5G SCPI Server... 0=
. @ Sawve Dutput frorm Selected Tab... [SDH[
. [ ol T oot TT T TS TS TSI T7rer TesTTesans: |

In the ‘Start VSG SCPI Server’ select ‘VSG’ as your ‘Alias Base’ (the value you entered
into the ‘VSG Base Name’ text box above). Leave HiSLIP selected and click ‘Start’.

-

Start WSG SCPI Server =

Aliaz Baze: ["-.ISG b ]

Praotacal; i@ HisLIP
(71 Sockets

(71 Telnet

Starting Part: | 5025

[ Start ] [ Cancel ]

Wait for all of your VSGs to start in the SCPI server console window.
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Step 5 - Quick Start Measurements

Starting M?38x
Started device
Started device
Started device
Started device

SCPFI Sewrvice

hislipl which
hizlip2 which
hizlip3d which
hizlip4 which

Press 'B' to exit

B | Ch\Program Files BnAgilenthb935:AbinYAg k93850 exe

to
to
to
to

Open the ‘Actions’ menu again and select ‘Configure VSG SCPI Server...’

r

o5 hulti-Channel P¥Ie Config Utility fver, 2,3.5)

File  Properties

92

Statuz

Help
Save Dewvice Aliases by Configured Marme

Save Device Aliases by Mew Mame and Channel...

=[]

<]
[0
[
[0

Delete &l Dewvice Aliases
. . Start WSG SCPI Server...
Configure WiG SCPT Server..,
. | Fun £
Sawe Output from Selected Tab..,
. [ Conlk T ook A L b A

[
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Step 5 - Quick Start Measurements

Leave HiSLIP selected and click ‘Configure’. After the success dialog is displayed,
click ‘OK’

b e =R <=

Pratacal; i@ HisLIP

) Sockets

Starting Part:| 5025

Configure ] [ Caricel

SUCCESS @

:I SCPI Configuration Success!

Load in the appropriate multi-channel setup file in the 89600 VSA Software by
selecting the File menu > Recall, Recall Setup... then navigating to the Multi-Channel
Utilities install location and going to Setup Files/LTE/{Dual Channel | Four Channel
(depending on your channel count)}/XxXMIMO_10MHzBw_Carrier_2GHz_OLSM.setx.
Load that file by clicking ‘Open’.

E Vector - Keysight 89600 W58 Softuare (64-hit)
File | Edit Contral Source  Input  MeasSetup  Trace  Markers  Windo

= Recall ] Recall Setup...

Preset r Recall Recarding... .
,zi Save 3 Recall Trace...

Copy Trace.., Recall Last Power-dowen Setup .

Recall Signal Studio Setup...
== Print., Ctrl+P Recall Layout..
Exit Alt+Fd Recall Display Preferences..,

Stant-3.423 uSec

Recall User Calar Map...

Recall Dermao..,

B: Chi Raw kain Time
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Step 5 - Quick Start Measurements

E Recall Setup

Look ir: Four Channel j ch‘: "

usz Marre Date rmodified Type
il |7 deAbAIM O _ShAHZEwe_Carrier_2GHz_OLSM.sete 4102015 3:53 P SETH File
|7 A O_10MHzEwe_Carrier_2GHz_OLSh.setc 4102015 3:52 P SETX File
! |7 A AMIM O_20MHzBwe_Carrier_2GHz_OLSM.sete 4102015 3:54 P SETX File
Desktop | InterBand LOMHzBW_2CC_2x2_T50_2100MHz.,  4/24/2014 403 P SETH File
— | Z LTE-TDD10MHz_4x4Bearnform_1 GHz. setx 54272015 B:46 AN SETX File

Recent Places

=g
Libraries

Computer

i
A
Metwark,

4 I

r
Fil= name: |4H4MII‘-1EI_'I Ok HzBw_Camer_2GHz_0 LSM.setj Open |
Files of type: |State Files [ sets, * set) j Caricel
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Step 5 - Quick Start Measurements

Start the VSG MIMO Demo Utility from your Start menu under All Programs > Keysight
> Multi-Channel Tools. This tool is used as a soft front panel for multi-channel VSGs.

E_T Windows Update
o MPE Viewer
 Accessaries
, Agilent
 Agilent TV Drivers
, Agilent Signal Studio
 Garnes
. Google Chrorme
| Keywsight
L hA938x
L hA9391
. hA9393
L Multi-Channel Tools
] M93814 %55 Correction Litility e
(] M93018 S8 Correction Uitilitye:
] Multi-Channel PXIe Config Utilit
] WG MIMO Dermo Utility.exe
L Eeysight 39600 Softuare 19.0
. keysight Cormrmand Expert

L Keysight Instrurnent Drivers

1 Back

Segrch rams gnd filss
prog P

Dermo

Docurments

Pictures

fusic

Cormputer

Contral Panel
Dewices and Printers
Default Pragrams
Help and Support

Wfimd o eCLItity

WCTT
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Step 5 - Quick Start Measurements

Setthe # of VSG Channels’ to the number of VSGs running in the SCPI server, make
sure ‘Write Changes to HW on Init’ is checked, leave ‘localhost’ as the TCP-IP
address, and click ‘Init’.

o MIMODemoGUL

Hardware Configuration | ‘wiavebomnz | Generator Settings
# of W56 Channels TCP-IP address
8 = lacalhast
[ Simulated Hardware ‘wirite Changes to Hw' on Init
[ Send erar queries ta W5G [ Loa SCPI commands

Go to the ‘Waveforms’ tab and select the ‘Load Waveforms From Config File’ button.

= Configuration | ' aveforms | Generator Settings|

[zer W avetarms

W aveform Alias Load zer
W aveform Files

Char 1 FileM arne
Chan 2 FileM arne
Charn 3 FileM arne
Char 4 FileM arne
Chan 5 FileM ame
Chan B FileM arne
Chan 7 FileM ame
Char 8 FileM arne

Load Y aveforms

W avefarm Config FileMame Fromn Caonfig File
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Step 5 - Quick Start Measurements

Then navigating to the Multi-Channel Utilities install location and going to Setup
Files/LTE/{Dual Channel | Four Channel (depending on your channel count)}/LTE X-

channel waveforms.csv. Load that file by clicking ‘Open’.

a5 Selectwavefarm canfig file

@n\:—/nv| € Program Files (x86) » Keysight » Multi-Channel Tools » Setup Files » LTE » Four Channel R4 |$¢|| Bearch Four Channel

Organize v New folder A= -

A Favorites Marme . Date modified Type Size

Bl Desktop LTE&-channel wawefarms,csv 41072015 1120 AW OpenOffice.org L., 2EE
& Dowenloads

2 Recent Places

o Libraries
3 Docurnents
Jv- Music
= Pictures

B videos

1M Computer
‘:-_-’1. SysternDrive (C2)

o RecoveryPartition (E

Gi_d Metwark

0

File name: LTE 4-channel waveforms,csw - ’Comma—Separatedﬁles ¥ v]

[oeen 1] |

Cancel

)
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Step 5 - Quick Start Measurements

Go to the ‘Generator Settings’ tab. Setall frequencies, amplitudes, IQ delays, and 1Q
phases for each channel number (up to the number of channels in your system) to
2000, -10, 0, and O respectively. Note: you may need to uncheck Track Frequency
Changes’and ‘Track Amplitude Changes’ to accomplish this.

Hardware Configuration | Wavefurms| Generator Settings |

RF/Bazeband settings | Playback/Trigger Settings|

RF Settings

Track Frequency Changes

Chan 1 Freq Chan 2 Freq Chan 3 Freq
2000000 = |MHz 2000000 = MHz (2000000 = MHz
Chan & Freq Chan & Freq Chan ¥ Freq
5200000 =-(MHz |5,200.000 = MHz (5200000 1= MHz
Track Amplitude Changes

Ch1 Amplitude ChZ Amplitude Ch3 Amplitude
-10.00 = gBmy [-10.00 “| dBm [-10.00 ~ dBm
ChS Amplitude Che &mplitude Chy Amplitude

-2.00 dBm | -2.00 dBm |-2.00 dBm

todulation Enable [F] Marow Bw PLL

RF Enable

B azeband Adjustments

Chan 110 Delay
0.000 = pz
Chan 510 Delay
0000 ~pz

Chan 110 Phaze
0.000 = |deg
Chan 510 Phaze
0,000 " deq

Chan 2 10 Delay
0.0ao = |pz
Chan B IQ Delay
0000 ~pz

Chan 2 10 Phaze
0.000 = deq
Chan B 10 Phaze
0,000 " deq

Chan 310 Delay
0.000 = pz
Chan 7 10 Delay
0000 ~pz

Chan 310 Phaze
0.000 = |deg
Chan 7 10 Phaze
0,000 " deq

Chan 4 Freq
2,000,000
Chan 8 Freq
5,200,000

* MHz
* MHz

Cha Amplitude
-10.00 :
Cha amplitude
-2.00

dBm

dBm

Chan 4 10 Delay
0.0ao = |pz
Chan 810 Delay
0000 ~pz

Chan 4 10 Phaze
0.000 = deq
Chan 810 Phaze
0,000 " deq

ALC Settings
[] ALE Enabled

= Of
Track on karker

Hald an Marker

Pulze Blank tMode
@ Off

(71 On owith Marker
(70 D with M arker
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Step 5 - Quick Start Measurements

Select ‘MIMO_T10MHz’ in the ‘Select Waveform box and click ‘Play Waveform’.

Select \Wavefarm:

MIMO_BMHz

IMO_20rHz

InterB and2x2
LTE-TDD10MHz_4x4Beamform

| Play " aveform |

ol

Look at your 89600 VSA Software window. You will now see an example wireless

signal.

25 LTE - Keysight 89600 VSA Software (§4-bit)
File Edit Control Source Input MeasSetup Trace Markers ‘Window Utiliies Help

Bl o Tan - [ ] off H- i fl 4 BiI MW [50% )| 0% Color Normal
A: Chl Spectrum E: Layer0 OFDM Meas I: Layer) OFDM Err Wect Time

Li Frame Summary

4

P: Error Summary ~

Measurement running

I: OFDM MIMO Info

INT REF

8

[im
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Appendix A - Return Instrument for Repair

Appendix A - Return Instrument for Repair

Return an Instrument for Service

Should it become necessary to return an instrument for repair or service, follow the
steps below:

Itis recommended that you return all modules and cables of the
M9381A or M9391A instrument for repair and calibration. If your
Keysight M9300A PXle Frequency Reference is operating
properly, you need not send it in with the other modules because
your instrument may be repaired and calibrated without your
M9300A. Doing so, however, will effect your calibration schedule,
since repairs are followed by calibration. The Calibration Due Date
for your MO300A will not match the date of your other modules.

1. Review the warranty information shipped with your product.

2. Contact Keysight to obtain a Return Material Authorization (RMA) and return
address. For assistance finding Keysight contact information, go to
www.keysight.com/find/assist.

3. Write the following information on a tag and attach it to the malfunctioning
equipment:

— Name and address of owner. A P.O. boxis not acceptable as a return
address.

— Module serial number(s). The serial number label is located on the side
panel of the module. The serial number can also be read from the Soft
Front Panel interface - after the hardware is installed.

- Description of failure or service required.

4. Packthe instrumentin its original packaging. Include all cables. If the original
packaging material is not available, use anti-static bubble wrap or packing
peanuts and place the instrumentin a sealed container and mark the container
-FRAGILE-.

5. Onthe shipping label, write ATTENTION REPAIR DEPARTMENT and the RMA
number.

In your correspondence, refer to the modules by serial number
and the instrument by model number.
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Appendix B - Options

Model - Option List for the Keysight M9381A PXle Vector Signal Generator.

M9381A
M9381A
M9381A-F03
M9381A-F06
MO381A-TEA
M9381A-UNZ
M9381A-B04
M9381A-B10
M9381A-B16
M9381A-MO1
M9381A-M0b
M9381A-M10
MO381A-UNT
M9381A-300

M9381A-UK6

M9381A-012

Description

PXle VSG: 1 MHz to 3 GHz or 6 GHz
Frequency Range, 1 MHz to 3 GHz
Frequency Range: 1 MHz to 6 GHz
High Output Power

Fast Switching

RF Modulation Bandwidth, 40 MHz
RF Modulation Bandwidth, 100 MHz
RF Modulation Bandwidth, 160 MHz
Memory, 32 MSa

Memory, 512 MSa

Memory, 1024 MSa

Analog Modulation

Keysight M9300A PXle Frequency Reference:

10 MHz and 100 MHz

Commercial calibration certificate with test
data

LO Sharing for Phase Coherency
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Appendix B - Options

Model - Option List for the Keysight M9391A PXle Vector Signal Analyzer

M9391A Description

M9391A PXle Vector Signal Analyzer: 1 MHz to 3 GHz
or 6 GHz

M9391A-F03 Frequency Range, 1 MHz to 3 GHz

M9391A-FO6 Frequency Range: 1 MHz to 6 GHz

M9391A-UNZ Fast Switching

M9391A-B04 Analysis Bandwidth, 40 MHz

M9391A-B10 Analysis Bandwidth, 100 MHz

M9391A-B16 Analysis Bandwidth, 160 MHz

M9391A-MOT Memory, 32 MSa

M9391A-M05 Memory, 512 MSa

M9391A-M10 Memory, 1024 MSa

M9391A-300 Add Keysight M9300A PXle Frequency
Reference: 10 MHz and 100 MHz

M9391A-UK6 Commercial calibration certificate with test
data

M9391A-012 LO Sharing for Phase Coherency
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Appendix C - Standard Configurations

LTE Standard Configurations can be found at the following link for:

— 2x2 LTE/LTE-A Solution (2 Sources and 2 Analyzers)

— 4-Channel LTE/LTE-A Signal Generation (4 Sources)

— 4-Channel LTE/LTE-A Signal Analysis (4 Analyzers)

— 4x4 LTE/LTE-A Solution (4 Sources and 4 Analyzers)

— 4x4 LTE/LTE-A Phase-Coherent Solution (4 Sources & 4 Analyzers)
— 8x8 LTE/LTE-A Solution (8 Sources and 8 Analyzers)

— 8x8 LTE/LTE-A Phase-Coherent Solution (8 Sources & 8 Analyzers)

At the following link, select the Standard Configurations tab for details on each
configuration.

http://www.keysight.com/find/solution-lte

For more information on LTE/LTE-A Multi-Channel Systems see:
- Solution Brochure 5991-4684EN
- Configuration Guide 5991-4647EN
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